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1

Getting Started

This section explains what the SystemTest™ software is and shows you how
to use it. It contains the following topics:

• “Product Overview” on page 1-2

• “Quick Tour of the SystemTest Software” on page 1-3

• “Running Tests from the MATLAB Command Line” on page 1-10

• “Example: Building a Test” on page 1-11



1 Getting Started

Product Overview
The SystemTest software provides MATLAB® and Simulink® users with a
framework that integrates software, hardware, simulation, and other types
of testing in one environment. You use predefined elements to build test
sections that simplify the development and maintenance of standard test
routines. You can save and share tests throughout a development project to
ensure standard and repeatable test verification. The SystemTest software
offers integrated data management and analysis capabilities for creating
and executing tests, and saving test results to facilitate continuous testing
across the development process.

The SystemTest software automates testing in MATLAB and Simulink
products. With the SystemTest software you get:

• Graphical test editing — Quickly edit your test within a graphical test
development environment.

• Repeatable test execution — All tests developed with the SystemTest
software share the same execution flow, which provides a consistent test
framework among tests.

• Parameterized testing — Create test vectors over which your test iterates.

• Reusability — After you design a test, you can save it for later use by you
or others.

• Maintainability — Because you design and execute tests from the
SystemTest desktop, you do not need to understand unfamiliar code or
concepts.

• Integration — The SystemTest software integrates with MATLAB,
Simulink, and other products based on MATLAB and Simulink.
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Quick Tour of the SystemTest™ Software

Quick Tour of the SystemTest Software

In this section...

“Getting Familiar with the Desktop” on page 1-3
“General Desktop Features” on page 1-5
“Setting SystemTest Preferences” on page 1-7
“Viewing Test Results” on page 1-9

Getting Familiar with the Desktop
The SystemTest desktop is an integrated development environment that
lets you perform all of your testing activities from one centralized location.
This section provides an overview of the SystemTest environment. For more
information about how to use the SystemTest software to build tests and run
them, see “Example: Building a Test” on page 1-11.

To get familiar with the SystemTest environment, open the SystemTest
desktop from MATLAB by selecting Start > MATLAB > SystemTest >
SystemTest Desktop or typing systemtest at the MATLAB command line.
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1 Getting Started

The desktop has a number of different panes that help you to build and run
your test.

• Test Browser— Shows the overall structure of a test. A test is made up of
Pre Test, Main Test, Save Results, and Post Test. Use the Test Browser to
add elements to your test. These elements determine what actions your
test performs.

• Test Vectors — Lets you define the parameters or test cases of your test.
The test vectors you define determine the number of iterations performed
by your test. Test vectors are automatically indexed during test execution.

• Test Variables— Lets you define variables used in the scope of your test.
Variables can serve both input and output functions in your test. You can
define variables that are declared in the Pre Test section of your test or in
the Main Test section of your test.
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• Properties — Shows the properties of the test or the element you are
editing. The contents of this pane change when you select a section or
element in your test.

• Elements — If open, this undocked Elements pane allows you to add
elements to your test. If not open, you can add elements using the New
button in the Test Browser.

• Resources — Lists the instrument or other external device resources
associated with the current test. This is only used if you have a license for
the Instrument Control Toolbox™ software.

• Getting Started — Shows information to help you start using the
SystemTest software. If the Getting Started page is closed, select Help >
SystemTest Getting Started to open it.

• Desktop Help — Shows help about the element or aspect of the test that
is currently selected. For the full product Help, select Help > SystemTest
User’s Guide.

• Run Status— Shows a summary of the test’s execution status.

General Desktop Features
The SystemTest desktop has a variety of features to make navigation easier.

Context Menus
Many areas of the user interface have context menus. For example, if you
right-click in the Test Vectors, Test Variables, Resources, Run Status,
Getting Started, or Desktop Help panes, you can access these context
menus.

If you have the Elements pane open, you can add elements to your test using
the context menus. If you right-click any element there, you can insert it
directly into Pre Test, Main Test, or Post Test using the Elements pane
context menus. If that section of the test already contains elements, the
inserted element will be placed below the currently selected element in that
section. You can change the order of elements in the test by using the arrow
buttons in the Test Browser, or by dragging and dropping.
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1 Getting Started

Hot Keys
The SystemTest software offers various keyboard shortcuts, or hot keys, to
access certain commands via the keyboard. For example, pressing F5 is an
alternative way to run a test, and pressing Ctrl+N creates a new untitled test.

See the full list of SystemTest hot keys in Appendix A, “SystemTest Hot Keys”.

Undo/Redo Support
Undo and redo support is available through the Edit menu or on the
SystemTest toolbar. This feature allows you to undo actions you have done
throughout the desktop. The undo queue is global to the entire desktop. For
example, if you add a test vector and then perform an action in the Properties
pane, those two actions will be the last two items in the queue. The undo
order applies across all the panes in the desktop.

To use this feature, select the Edit > Undo action command, where action
is the last action you performed. Use the Undo command repeatedly to
undo multiple actions. The Edit > Redo action command will redo the last
undo you performed.

Most actions in the desktop are undoable. Some actions pertaining to the
elements that are part of the hardware toolboxes, Data Acquisition Toolbox™,
Instrument Control Toolbox, and Image Acquisition Toolbox™, cannot be
undone since they involve connections to hardware.

The following actions will clear the list of actions in the undo queue:

• Closing a test

• Opening a test

• Creating a new test

• Refreshing a Simulink model in the Simulink element
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Setting SystemTest Preferences
You can set SystemTest preferences by selecting File > Preferences on
the SystemTest desktop. This opens the MATLAB Preferences dialog box.
Click SystemTest in the left tree if SystemTest Preferences are not showing
in the right pane.

Most Recently Used Test List
This option determines how many tests will appear on the SystemTest File
menu’s most recent files list. The default is 4 tests. If you change it to 0, no
recent tests will appear on the list. The maximum number is 9.
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Test Run Options
Select Minimize SystemTest when starting a test if you want the
SystemTest desktop to minimize when a test starts running. This check box
is cleared by default.

Select Save test before running if you want the SystemTest software to
save your test before it runs. If this option is selected and you run a test
that is not yet saved, you will be prompted to name and save the test. This
check box is selected by default.

Note You can save a test any time, before or after running it, by selecting
File > Save.

Confirmation Dialog Boxes
You can also turn off confirmation dialog boxes used in the SystemTest
software in a different area of the Preferences dialog box by selecting General
> Confirmation Dialogs. Three SystemTest confirmation dialog boxes are
listed there, as shown in the figure that follows.

• Warn about launching Test Results Viewer without any saved
results— Occurs if you attempt to open the Test Results Viewer when the
latest test that ran does not contain any mapped results under Saved
Results. To save results, click Saved Results in the Test Browser.

• Warn about using a Simulink model with an infinite simulation
stop time — Occurs if you attempt to run a test containing a Simulink
element that uses a model with an infinite simulation stop time.

• Warn about using a Simulink model with unnamed logged signals
— Occurs if you have a model that has logging enabled but has logged
signals with no name, and you use that model in a Simulink element in the
SystemTest software.
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Viewing Test Results
The SystemTest software includes the Test Results Viewer that you can use
to view the results you have chosen to save for your test. Launch the tool from
the SystemTest Tools menu by selecting Tools > Test Results Viewer. You
can also configure the SystemTest environment to launch the Test Results
Viewer automatically after all test results you specified have been saved for
each iteration and test execution has completed. For more information, see
“Analyzing Your Test Results” on page 1-37.
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Running Tests from the MATLAB Command Line
You can run one or more SystemTest tests from the MATLAB command line,
using the strun function. This is useful for running multiple test files as a
batch or calling a test file as part of an M-file.

Note If you use this feature, it is a good idea to first run the test from the
SystemTest desktop to verify that elements are not in an error state, and that
the test will run successfully, before running it via the MATLAB command
line using the strun function.

The function takes the name of your test file as a string. The test file must be
on the MATLAB path, or you can specify the full path in the string.

For example, to run a test called mytest that is on the MATLAB path, use
this syntax:

strun('mytest')

To run a test called mytest that is not on the MATLAB path, but is in a local
directory called c:\work, use this syntax:

strun('c:\work\mytest.test')

To run multiple tests, use a cell array of strings, as follows:

strun({'mytest' 'mytest2'})

Note MATLAB will remain busy while tests are executing via the strun
command. Control is returned to the MATLAB command line once all tests
execute.

For more information about using strun, see the function page.
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Example: Building a Test

In this section...

“Overview” on page 1-11
“Planning Your Test” on page 1-11
“Building Your Test” on page 1-12
“Running Your Test” on page 1-34
“Analyzing Your Test Results” on page 1-37

Overview
This simple example illustrates the four primary stages of testing: planning,
building, running the test, and viewing test results.

The example uses a simple MATLAB expression to emulate a scalar
measurement during each iteration of the test. The example uses an arbitrary
formula dependent on the test vector named signal to generate the Y data.
The example tests each measurement to determine if it falls within certain
specified limits. If a measurement exceeds these limits, that particular
iteration of the test fails. By default, the test fails if any iteration fails, but
you can configure other pass/fail criteria.

The following sections provide more information about each stage, building
the example test along the way. If you prefer, instead of working through the
following sections to build the example, you can load it into the SystemTest
software by running the Getting Started with SystemTest demo from the
Demos page in the MATLAB Help browser (under MATLAB > SystemTest
> MATLAB) or by entering systemtest Simple_Demo at the MATLAB
command prompt.

Planning Your Test
In this first stage, you must identify what it is you want to test. The
SystemTest software lets you specify input data, such as measurements from
a model or device, and compare this input data to some predefined limits.
Based on this comparison, the SystemTest software can declare whether
a test passes or fails.
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Keep the following in mind as you plan tests:

• Identify your test data and test vectors.

• Specify test limits and determine if these limits can be expressed as scalar
or matrix values. (The Limit Check element supports both scalar and
matrix data.)

• Determine what operations your test must perform. Must certain
operations happen before others?

• Determine pass/fail criteria for your test.

• Decide which test variables you want to save as test results.

After this planning, you can begin to construct your test, which is described in
“Building Your Test” on page 1-12.

Building Your Test
The SystemTest interface provides a graphical integrated environment that
you can use to create and edit tests. Tests consist of elements, test vectors,
and test variables. You can use each of these entities to create a variety
of test scenarios ranging from a simple test that runs a series of elements
once to a full parameter sweep that iterates over the values of test vectors
that you define.

The following sections show how to construct a test:

• “Starting the SystemTest Software” on page 1-13

• “Structuring Your Test” on page 1-13

• “How Test Vectors and Test Variables Relate to the MATLAB Workspace”
on page 1-15

• “Creating a Test Vector” on page 1-15

• “Defining Test Variables” on page 1-18

• “Adding Elements” on page 1-20

• “Defining Pass/Fail Criteria” on page 1-29

• “Saving Test Results” on page 1-30
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• “Test Report” on page 1-32

• “Saving Your Test” on page 1-33

Starting the SystemTest Software
Start by opening the SystemTest desktop using the MATLAB Start button.
To open the SystemTest software, select Start > MATLAB > SystemTest >
SystemTest Desktop.

Alternatively, you can execute the systemtest command from the MATLAB
command line.

The SystemTest software displays the desktop on your screen. See “Quick
Tour of the SystemTest Software” on page 1-3 for an overview.

Structuring Your Test
The SystemTest software divides tests into three sections.

• Pre Test — This section is used to execute test elements in order to
perform any test set-up operations, such as initializing variables, loading
data from a file, and initializing system resources. Using Pre Test
variables, you can assign an initial value to a test variable that persists
between Main Test section iterations (unless another element in Main Test
modifies the value). Pre Test is not mandatory, but it can be used if your
test requires set-up operations to be performed.

• Main Test — Main Test defines the test elements that need to be
performed across the parameter space defined by your test vectors. In this
section Main Test variables are initialized before each Main Test iteration,
which lets you assign an initial value to a test variable each time the Main
Test runs. This is useful if your test variable has a derived value such as
being indexed by a test vector or is the result of a MATLAB expression.

The number of iterations performed in the Main Test is indicated in the
Test Browser in parentheses after Main Test. Iterations specifies the
number of times the Main Test section will be run. This is determined from
the test vectors you define. The SystemTest desktop also offers a Save
Results area for you to specify which test variables you want to save as
test results at the end of each Main Test iteration.
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• Post Test— In this section you can perform any cleanup work necessary
at the completion of the Main Test section, such as clearing workspace
variables, closing a file, or freeing system resources.

For details about the sections of the test, see “Working with the Sections
of a Test” on page 3-2.

The following figure illustrates the structure of a test.
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How Test Vectors and Test Variables Relate to the MATLAB
Workspace
The SystemTest software has its own internal workspace that it uses to
manage test variables and test vectors independently. However it does
leverage the MATLAB workspace during test execution, and when using
a MATLAB element.

During test execution, SystemTest test variables and test vectors are
evaluated in the MATLAB base workspace. Then at the end of test execution,
they are cleared out and the MATLAB base workspace is restored to what it
was before the test execution.

When using a MATLAB element in the SystemTest software, you can
reference a variable in the base workspace without having to create a test
vector or test variable in the SystemTest software. However the SystemTest
software will not be aware of this data, so you could not make use of it in any
other element type or in saved results. You can only access it from a MATLAB
element. If you need to use it in other elements, you can create test variables
or test vectors in the SystemTest software.

Creating a Test Vector
Test vectors are composed of values derived from a MATLAB expression. You
can use any MATLAB expression that evaluates to a 1-by-n matrix or cell
array to define your test vector. Using test vectors, you can iterate through
a range of values to see how a system performs. Test vectors constitute
parameterized testing in the SystemTest software. They are the test cases
for your test.

For tests with multiple test vectors, the product of the lengths of the test
vectors defines the number of iterations the test performs. For example, if you
define the test vector [10 20 30], the test runs three times, using a value of
10 for the first run, 20 for the second, and 30 for the final run. If you add a
second test vector with three other values, the total number of test runs would
be nine. The SystemTest software iterates through each vector in combination
with the other vector as though the test were a group of nested FOR loops—the
outermost loop being the first test vector in your table and the innermost loop
being the last test vector. TheMain Test section in the Test Browser shows
the total number of test iterations defined by your test vectors.
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For the example, use the vector [pi/15:pi/15:4*pi] which defines 60 values
for our test vector ranging from pi/15 to 4*pi in pi/15 increments. To specify
this test vector:

1 Click the New Vector button in the Test Vectors pane.

The Insert Test Vector dialog box opens.

2 Keep the default test vector type ofMATLAB Expression. Assign a name
to the test vector by clicking the Name field. For this example, name the
test vector signal.

3 Assign a value to the test vector by clicking the Expression field. Enter
the test vector specified above for the pi values. Click OK.
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After you create the test vector, in the Test Browser pane, the Main Test
section label updates to include the number of iterations defined by the test
vector. It should say Main Test (60 Iterations).
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Note Grouping test vectors determines how they will be iterated through
when the test runs. For information on grouping vectors, see “Creating
Grouped Test Vectors” on page 2-5.

Note You can also use probability distributions when you create a test vector.
For information, see “Creating Randomized Test Vectors with Probability
Distributions” on page 2-18.

Defining Test Variables
The SystemTest software uses test variables to define temporary storage
variables that a test acts on or generates. You assign test variables in the Pre
Test or Main Test sections of your test.

You can define Pre Test variables or Main Test variables. Using Pre Test
variables, you can assign an initial value to a test variable that persists
between Main Test section iterations (unless another element in Main Test
modifies the value). Pre Test is not mandatory, but it can be used if your test
requires set-up operations to be performed.

Main Test defines the test elements that need to be performed across the
parameter space defined by your test vectors. Main Test variables are
initialized before each Main Test iteration, which allows you to assign an
initial value to a test variable each time the Main Test runs. This is useful if
your test variable has a derived value such as being indexed by a test vector
or is the result of a MATLAB expression. You add elements in this section.

The example test requires three test variables:

• Y — Contains a value that will be calculated from the signal test vector
at each iteration.

• HiLimit— Contains the upper limit for Y that you do not want the signal
to exceed.

• LowLimit— Contains the lower limit for Y that you do not want the signal
to go below.
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To create these test variables:

1 Click the Test Variables tab in the middle pane of the SystemTest desktop.

2 Click the New button to create a Pre Test or Main Test variable. The
Insert Test Variable dialog box opens. Leave the default value of Main
Test in the Assigned in field, to create a new Main Test variable.

3 Assign a name to the test variable by clicking the Name field and entering
the test variable name. For this example, enter Y.

4 Set the test variable’s initial value by clicking the Initial Value field and
entering a value. For the example test variable Y, enter 0. Click OK.

Note If you do not provide an initial value, it will default to empty, that
is, Var1 = []; in MATLAB code.
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Note Test variables are re-initialized at the start of each test iteration.
The Initial value field is blank by default when you create a test variable.
If you leave it blank, it will initialize to []. If you enter an initial value
(which can be any valid MATLAB expression), that value gets assigned in
every iteration.

5 Repeat steps 2 to 4 to create the remaining two test variables, using the
settings listed in the following table:

Variable Name Initial Value Assign in

HiLimit 1 Main Test
LowLimit -1 Main Test

Adding Elements
Elements are the actions that a test performs. The SystemTest software
includes the following set of elements, listed in alphabetical order.

• IF — Implements a logic control operator.

• Limit Check — Specifies the comparison to be performed of the value(s)
under test and their expected value(s), or limit(s).

• MATLAB — Executes any MATLAB statements.
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• Scalar Plot — Graphically shows the value of any test variable or vector, as
the test is executing, as a scalar plot.

• Simulink — Runs a Simulink model. Note that you need to have a license
for Simulink to use this element.

• Stop — Implements a logic control operator.

• Subsection — Creates a new section in a test that you can use to group
elements within.

• Vector Plot — Graphically shows the value of any test variable or vector, as
the test is executing, as a vector plot.

Note Some MathWorks products, such as the Image Acquisition Toolbox™
software, the Data Acquisition Toolbox™ software, and the Instrument
Control Toolbox™ software, provide their own elements that integrate those
products’ capabilities within the SystemTest software. If you have licenses for
those products, those elements will also appear in the elements list.

For more information about using the basic elements, see Chapter 3, “Working
with the Basic Elements”.

You add elements to a section in your test; however, not all elements can be
added to all sections. For example, you can use a MATLAB element anywhere
within a test, but you can only use the Limit Check element in the Main
Test section.

To illustrate using elements, let’s continue with this example. This test uses
three elements in the Main Test section.

Element Description

MATLAB Use a MATLAB expression to assign data to Y that is
dependent on the test vector signal.
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Element Description

Limit Check Compare the value generated in the MATLAB element to
the specified limit and see if the Y test variable exceeds
the upper or lower limit you defined in your HiLimit and
LowLimit test variables.

Scalar Plot Plot the current test variable values and see whether the
test variable exceeds the upper and lower limits.

To add these elements:

1 Select the section of the test in which you want to add the element. For this
example, click Main Test in the Test Browser.

2 Specify the element you want to add to the test section. For this example,
click the New > Test Element button and select MATLAB. A MATLAB
element appears in the Main Test section of your test and the MATLAB
element property page opens in the Properties pane of the SystemTest
desktop.
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3 In the Properties pane, type the following M-code in the MATLAB Script
edit box. This MATLAB code calculates a value for Y that is dependent
on the test vector signal.

Y = sin(signal)+ rand -.5;

During each iteration, the SystemTest software evaluates the MATLAB
expression and assigns a value to Y.
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4 Add the Limit Check element to the Main Test section of the test. With
the MATLAB element selected, click the New > Test Element button,
and click Limit Check. A Limit Check element appears in the Main
Test section of the test and the Limit Check properties page opens in the
Properties pane. For this example, the Limit Check element must follow
the MATLAB element in the test.

Note You can reposition an element in a test by selecting the element and
then clicking the up and down arrows in the Test Browser toolbar. You
can also drag and drop elements within Main Test. You cannot move
elements between test sections.
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In the General Check tab, click the New button to add a limit check.
Notice that the Limit Check element icon in the Test Browser shows
a red x, which indicates that information is missing. The corresponding
red outlining in the Properties pane highlights any fields that require
configuration. A test cannot run unless everything is properly configured.
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5 Specify the limit comparison operations in the Limit Check element.

a In the Test Variable column, click the drop-down list and select a test
variable you created in step 4. For this example, select Y.

b In the Operator column, click the drop-down list and select the
comparison you want to perform. For this example, pick the
less-than-or-equal-to operator, <=.

c In the Limit column, click the drop-down list and select the test variable
you want to compare to. For this example, select HiLimit, which is the
test variable you created earlier.

The following figure shows the configuration of this limit.

6 To add another limit comparison operation, click the New button again in
the General Check Properties pane. A new row appears below the last
limit you specified. In this new row, set Test Variable to Y, set Operator
to >=, and set Limit to LowLimit.
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The following figure shows the configuration of this second limit.

For each iteration of the Main Test, the MATLAB element’s expression is
evaluated and a new value assigned to Y. When the Limit Check element
runs, it determines whether the value of Y falls between the HiLimit and
LowLimit values. If Y is outside this range, the test iteration fails. The
default pass/fail criteria for the overall test passes the test only if both
expressions in the limit check evaluate to true.

7 To view the test variables as the test runs, plot the data. To add a Plot
element to the test, click the New > Test Element button, and select
Scalar Plot. A Scalar Plot element appears in the Main Test section, and
the properties page for the element opens in the Properties pane.
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With each Main Test iteration of the test, the Scalar Plot element updates
a figure window with data you selected.

8 Click the New button twice in the Properties pane and set the three
rows to match the following table.

Y Axis Line Color Line Style Line Marker

Y Blue Solid Point
HiLimit Red Dashed No Marker
LowLimit Black Dashed No Marker
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Defining Pass/Fail Criteria
You can define whether your test passes or fails by monitoring the outcome of
any or all Limit Check elements during any or all Main Test iterations. Your
test’s threshold of success can range from the passing of any Limit Check in
any single test iteration to the passing of all Limit Check elements in all test
iterations. If your test contains no Limit Check elements, there is no notion
of pass/fail and no pass/fail information is displayed. (Testing of this type
is useful for experimenting with a system or to explore its behavior rather
than validate its performance.)

You can set any of the following conditions to define when your test passes:

• All Limit Check elements pass in all test iterations.

• All Limit Check elements pass in any test iteration.

• Any Limit Check element passes in all test iterations.

• Any Limit Check element passes in any test iteration.
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You can configure this behavior within the test’s Properties pane. Click the
test name in the Test Browser (named Untitled by default) to open the
test’s properties and look for the section labeled This Test Passes If.

Using the signal test example that you constructed in this section, set the test
to pass if all Limit Check elements pass in all test iterations.

Saving Test Results
You can save the results from the iterations of your test in a MAT-file. You
must explicitly specify which test variables you want to save as test results.

The SystemTest software lets you save results at the end of each iteration.
Before you run your test, select the Save Results section in your test and
specify which test variables to save as test results. Click the New Mapping
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button and then select from the drop-down list the name of the test variable
you want to map to a result. You can optionally specify a name for the results
that you want to save. By default, the name of the saved result will be the
same as the test vector or test variable. The following figure shows the
mapping of test variables to test results.

After you specify which test variables to save as test results, you can specify
the name of the MAT-file to use. Using this MAT-file you can reload the
test results into the base workspace. By default, the SystemTest software
names the file Untitled_results.mat and puts the file in the current
working directory (visible in the SystemTest toolbar). To change the name or
location of the MAT-file, click the test name in the Test Browser, then in the
Properties pane, use the Test Results Save Options field.

By default, each time you run the test you overwrite this file unless you select
the Create new numbered test results option on the test Properties pane.

Note Test variables that are not saved as a test result will be lost at the end
of the test execution.
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Test Report
When you run your test, status of the test appears in the Run Status pane.
This display contains basic information about your test:

• Time elapsed since your test started running.

• Which section your test is in.

• How many test iterations have passed or failed as defined by any limit
checks.

• Whether your test completed successfully.

• Any errors that cause your test to stop.

You can generate and save more detail about the running test by enabling
the Test Report, which is a test execution log file in html format. This report
is especially useful when you use limit checks in your test and you want to
see specific test iterations that passed or failed. For example, instead of just
finding that a test iteration failed, the report helps you determine how far a
test variable varied from the upper or lower limit defined in a Limit Check
element. This report is also useful for documenting and sharing your test
results.

To enable the Test Report, click the Generate a report of the test
execution option button on the Test Properties pane.

The Test Report contains the following information about the test run,
organized by iteration in the report:

• The test description, if you entered one in the Properties pane of the test.

• A test summary, including start and stop times, number of iterations
completed, number of iterations that passed and failed, and final status
of the test.

• Pass/fail results of Limit Check elements, by iteration.

• Values for any saved results you captured by setting up mappings in Saved
Results, by iteration.

• Test vector values, by iteration.

• A snapshot of your model if you use a Simulink element in the test.
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• A snapshot of your plot if you use a Vector Plot or Scalar Plot element in
your test, by iteration.

• A summary of generated files, with links to them. These can include a
Simulink model coverage report and the test results launched in the Test
Results Viewer.

Note Because the Test Report generates while the test is running, this
option results in the test taking longer to execute.

The report file is located in a subdirectory of the folder where you have
chosen to store your test results MAT-file. The subdirectory will be named
<testname>_report, where testname is the name of the active test. The Test
Report will be stored in this directory, along with all dependent files, such as
plot or Simulink model snapshots. The overwrite options you set for your test
results MAT-file also apply to the file name and directory of your report file.
See “Saving Test Results” on page 1-30 to learn how to change these options.

See “Viewing the Test Report” on page 1-37 to see what information the
report generates.

Saving Your Test
You can save tests so that you can reuse them later. For example, to save
the signal test:

1 Select File > Save As to open the Save file as dialog box.

2 Select a directory location and enter mySavedTest in the File name field.

3 Click Save.

The SystemTest software saves the test as mySavedTest.test and renames
your test as it appears in the Test Browser. This does not rename the test
results MAT-file or the Test Report file. Their names are controlled separately
from the name of the test, as explained in “Saving Test Results” on page 1-30.
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Running Your Test
After you build a test, you are ready to run it. At run time, the SystemTest
software assigns values to test vectors and test variables in the order they
appear in the Test Vectors and Test Variables panes. Each test section
runs elements in the order that they appear in the Test Browser.

To execute your test, do one of the following:

• Click the Run button.

• Select Run > Run.

• Press the F5 key.

Note While a test is running, you can stop its execution by pressing Ctrl+C
or clicking the Stop button on the toolbar.

Tracking Output
While the test runs, the Run Status pane shows summary test output,
including start and stop times, number of iterations completed, number of
iterations that passed and failed, and final status of the test. It will also
display any error messages if the test has an error.
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If your test includes a Plot element, the SystemTest software creates the
plot and updates the plot during each iteration. Since Limit Check elements
evaluate whether an iteration passed or failed, they directly affect the data
that appears in the Test Report and the Run Status pane.

In the example test, the plot includes the high and low limits defined in the
Limit Check element, to show which test iterations exceed the limits.

1-36



Example: Building a Test

When the test is done running, the Run Status pane provides links to
generated output. The Generated Files section contains a summary of
generated files, with links to them. These can include the Test Report; the test
results, opened in the Test Results Viewer; and a Simulink model coverage
report, if your test uses the model coverage feature.

Analyzing Your Test Results
After the SystemTest software runs your test, you can explore the results that
are generated. This section shows how to:

• View and interpret the Test Report.

• Inspect your test results with the Test Results Viewer.

Viewing the Test Report
When you enable the Test Report, the SystemTest software saves information
about each test iteration in an HTML file. To enable the Test Report, check
the Generate a report of the test execution option on the Properties
pane before running your test. The report contains summary information
about the test run, snapshots of any plots you used, snapshots of any models
you used, pass/fail results of Limit Check elements, and other information.
See Test Report for a full description of what the report contains.
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After a test runs, you can see the contents of this file by clicking the Test
Report button on the SystemTest toolbar or using the Test Report link in
the Run Status pane. The generated output resembles the following.
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The Main Test section of the report shows each iteration. You see the value of
the test vector signal and determine the values the Limit Check element used
in evaluating whether the test passed. For the first several iterations, the
value of Y did not exceed either the high or low limits so the iterations passed.
You can also see this in the scalar plot drawn while the test ran. For other
iterations that failed, you can scroll through the report to find the values of Y.

Viewing Test Results in the Test Results Viewer
To help you analyze your test results, the SystemTest software includes a tool,
called the Test Results Viewer, that provides a variety of plotting tools and
the ability to compare data. With this tool, you can see how your test results
compare to the test vectors used as inputs to your test.

You can start the Test Results Viewer by selecting it from the Tools menu.
You can also configure a test to launch the Test Results Viewer automatically
when the test completes. To do this, select the test in the Test Browser
and select the Visualize and plot saved results by launching the Test
Results Viewer option on the test’s Properties pane.

The test vectors in your test and the test results you selected to be saved
appear within the viewer so you can immediately start to explore your data.
For any selected test vector or test result, you can see a summary of statistics
for its values in the Data pane. For example, after running the test, the
viewer opens showing the saved test results and signal test vector. Clicking
the Y test result shows information such as the highest and lowest values that
Y evaluated to during the test. It also shows the mean, median, and standard
deviation for all values.
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The viewer has a rich selection of plotting capabilities that you can use to
visualize your test results. Plotting capabilities include line, scatter, time
series, surf, waterfall, and image plots. Using the signal example, you can
reproduce the line plot that your scalar plot element generated during the test.

1 Click the Line Plot button.

1-40



Example: Building a Test

2 In the Define Plot pane, click the X Axis list and select signal. Note that
you should choose signal or Auto values for the X-axis if you want to show
test vectors; line plots that use the X-axis for test vectors let you see how
each test iteration value corresponds to a test result.

3 Click the Y Axis list and select Y.

4 Click the Plot button.

You now have a line plot that resembles the scalar plot.

You can make this plot show the HiLimit and LowLimit test results too.
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1 In the Define Plot pane, click the Multiple Y Data option. The Y Axis
field expands to show all saved test results from your test.

2 Select the check boxes next to HiLimit and LowLimit.

3 Click the Refresh Plot button.

Constraining Data for Further Analysis
Using the Test Results Viewer constraint capability, you can filter out data.
For example to see only the test iterations that passed the test, you can create
two constraints that screen out data that exceeds the upper and lower limits.

Note By default, the Test Results Viewer provides a list of test vector
constraints for you to choose from.

To create and configure the constraints:

1 Click the New Constraint button in the Constraints pane to open the
Add a New Constraint dialog box.

�������	
���
���

��

2 Click the Using a result or test vector option button.

3 Select Y from the list.
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4 Click OK. A new constraint appears in the Constraints pane.

5 Create another constraint by repeating steps 1 to 4.

6 Click the check box next to the first constraint to activate it.

7 Make sure the operator is set to >=.

8 Click the constraint’s text field and change the constraint to -1.

9 Click the check box next to the second constraint to activate it.

10 Click the operator and set it to <=.

11 Click the constraint’s text field and change the constraint’s value to 1.

The green indicator bar beneath the constraints shows how many iterations
remain following the filter you applied. This is also reflected in the line plot,
which the viewer redraws after you apply the new constraints. As you can
see, only a subset of your test result remains.
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You can just as easily show only the iterations of your test that failed by
reconfiguring the constraints you created to filter out data that is < -1 or
> 1. Alternatively, you can create a new constraint that uses a MATLAB
expression. For example:

1 Delete the constraints you just created.

a Select the constraint row.

b Click the Delete button.

2 Click the New Constraint button in the Constraints pane. The Add a
New Constraint dialog box appears.

3 Click the Using a MATLAB expression option button.

4 Enter the expression Y<-1||Y>1.

5 Click OK.

6 Select the check box next to the constraint.

The Test Results Viewer redraws the line plot to now show only those test
iterations that failed.
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For more information about the Test Results Viewer, see Chapter 9, “Using
the Test Results Viewer”.

Saving Your Test Results
You can save the plotting and analysis work done in the Test Results Viewer.
Data, constraints, and plots created in the Test Results Viewer can be saved
and then reloaded in order to continue working on or viewing the data, or to
share it with others.

To save your test results and the state of the Test Results Viewer, use the
File > Save Test Results or File > Save Test Results As commands from
the Test Results Viewer desktop.

For more information on what is saved and how to reload your saved files, see
“Saving and Reloading Test Results” on page 9-42.

1-45



1 Getting Started

1-46



2

Working with Test Vectors

• “Creating MATLAB Expression Test Vectors” on page 2-2

• “Creating Grouped Test Vectors” on page 2-5

• “About Test Vectors and the MATLAB Workspace” on page 2-12

• “Creating MAT-File Test Vectors” on page 2-13

• “Creating Randomized Test Vectors with Probability Distributions” on
page 2-18
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Creating MATLAB Expression Test Vectors
Test vectors define the parameter space or set of test cases you want to run.
Test vectors are composed of values that can be derived from a MATLAB
expression. You can use any MATLAB expression that evaluates to a 1-by-N
matrix or cell array to define your test vector. You must have at least one test
vector defined to run a test.

The total number of Main Test iterations is determined by permuting all test
vector values. For example, if one test vector is a 1-by-3 array and another is
1-by-2, it would result in a total of six iterations covering all the test vector
value combinations.

To add a test vector:

1 Click the New Vector button in the Test Vectors pane.

In the Insert New Test Vector dialog box, keep the default test vector type
of MATLAB Expression.
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2 Assign a name to the vector in the Name field.

3 Enter the value by typing in values or a MATLAB expression in the
Expression field.

The Size field fills in automatically based on what you entered if you press
Enter or click outside of the Size field. For example, if you entered 1 : 1
: 10 in the Expression field, the Size would be a 1 x 10 double, which
means 10 iterations.

4 Select the Evaluate Test Vector each time the test is run option if
you want to use new values every time the test is run. For example, if
your expression included a rand function, a new set of random numbers
would be calculated each time. Leave it unselected if you want to use the
same values each time the test is run.
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5 Click OK in the Insert Test Vector dialog box.

The new vector appears in the Test Vectors pane.

Note Grouping test vectors determines how they will be iterated through
when the test runs. For information on grouping vectors, see “Creating
Grouped Test Vectors” on page 2-5.

For an example of creating test vectors in a test, see “Creating a Test Vector”
on page 1-15.
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Creating Grouped Test Vectors
When you create a test vector, it is an ungrouped vector by default, except
for Probability Distribution test vectors. You can also create grouped vectors,
in order to affect the way iterations are run. By grouping test vectors, they
will be indexed simultaneously with the other vectors in their group. Each
set of grouped values are then permuted with all the ungrouped test vectors.
This gives more control over the flow of tests and is useful for Design of
Experiments (DOE) or Monte Carlo-based testing as well as defining signal
groups, similar to those defined in the Simulink Signal Builder block.

For example, if you are testing a throttle body controller, you may want to
sweep across a range of input level or gain values, while simultaneously
selecting different throttle body types, each defined by their mass and
damping characteristics.

An example of the vectors in this scenario could look like this:

gain = [1 10 100]
mass = [a b c d]
damping = [w x y z]

If the gain vector is ungrouped, and the mass and damping vectors are
grouped, it will result in mass and damping being indexed simultaneously for
each value of gain. The test runs would look like this:

Run 1: (1, a, w)
Run 2: (1, b, x)
Run 3: (1, c, y)
Run 4: (1, d, z)
Run 5: (10, a, w)
Run 6: (10, b, x)
Run 7: (10, c, y)
Run 8: (10, d, z)
Run 9: (100, a, w)
Run 10: (100, b, x)
Run 11: (100, c, y)
Run 12: (100, d, z)
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Note Grouped test vectors must be the same length.

You create a grouped test vector as you do any other vector, by clicking the
New Vector button in the Test Vectors pane. To group a vector, change the
selection using the Grouping tab in the Insert Test Vector dialog box. You
can group any type of test vector, and you can create multiple test vector
groups. You can also group or ungroup test vectors after you create them.

In general, it doesn’t usually make sense to group Signal Builder Block
test vectors or Simulink Design Verifier Data File test vectors. There are
advantages to grouping MATLAB Expression, Probability Distribution, and
Spreadsheet Data test vectors at times, depending on your test goals. One
of the main advantages to grouping is for Monte Carlo-based testing, as
described by the example above.

To group a test vector:

1 Create a test vector and configure it in the General tab of the Insert Test
Vector dialog box.

2 Click the Grouping tab in the Insert Test Vector dialog box.

3 Select the Assign test vector to a group option.

A group is created and given the default name of Group1, as shown here.
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4 To change the name, type the new name over the default name and press
Enter.

5 Click OK in the Insert Test Vector dialog box.

In the Test Vectors pane, the name of the group is displayed in the table.

6 Now if you create another test vector, you can add it to the same group as
the first one. To do this, click the New Vector button again.

7 Select the test vector type and configure it in the General tab.

8 Click the Grouping tab, and select the Assign test vector to a group
option.

Note that test vectors in a group must all be the same length.
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If you already have one test vector group, the new vector is placed in that
group by default.

9 Click OK in the Insert Test Vector dialog box.
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You can create multiple test vector groups. Once you have multiple groups,
when you create new test vectors, you can select which group to put them in as
you create them. The following figure shows Group1 containing TestVector1
and TestVector2, and Group2 containing TestVector3 and TestVector4.
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You can also create groups after test vectors are already created by editing a
test vector in the Test Vectors pane. Select a test vector in the table to edit
its properties in the editor area below the table. There you can add it to a
group using the Grouping tab. You can also add it to a group in the table by
clicking in the Group Name column.

Managing Test Vector Groups

You can modify groups to ungroup a test vector, move a test vector to another
group, rename a group, or delete a group.

• Ungroup a test vector — To remove a test vector from a group, select
it in the test vectors table, then click the Group Name column. Use the
down-arrow to select the first entry, which is a blank space. The Group
Name column will then be empty for that test vector, indicating it is no
longer in a group.

• Move a test vector to another group— To move a test vector from one
group to another, select it in the test vectors table, then click the Group
Name column. Use the down arrow to select the group to move it to. The
Group Name column will then show the new group name.

• Rename a group— You can change the name of a test vector group either
in the table or in the editor area. Renaming a group in the table results
in the group name for a single test vector being changed. Renaming a
group in the editor area results in the name being changed for all vectors
in the group.

To rename a group for a single test vector, select that vector in the table,
then click in the Group Name column. Type a new name and press
Enter.
To rename a group for all test vectors in the group, select one of the
test vectors in the table. Then in the Grouping tab in the editor area,
select that group name in the upper section and type a new name. Press
Enter. You then see all of the test vectors in that group change to the
new name in the table.

• Delete a group — To delete a test vector group, select one of the test
vectors in the table that is in that group. Then in the editor area, under the
Grouping tab, that group name will be selected. Click the Delete button
on the Grouping tab. The group is deleted and all test vectors belonging
to that group become ungrouped.
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About Test Vectors and the MATLAB Workspace
The SystemTest software has its own internal workspace that it uses to
manage test variables and test vectors independently. However it does
leverage the MATLAB workspace during test execution, and when using
a MATLAB element.

During test execution, SystemTest test variables and test vectors are
evaluated in the MATLAB base workspace. Then at the end of test execution,
they are cleared out and the MATLAB base workspace is restored to what it
was before the test execution.

When using a MATLAB element in the SystemTest software, you can
reference a variable in the base workspace without having to create a test
vector or test variable in the SystemTest software. However the SystemTest
software will not be aware of this data, so you could not make use of it in any
other element type or in saved results. You can only access it from a MATLAB
element. If you need to use it in other elements, you can create test variables
or test vectors in the SystemTest software.
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Creating MAT-File Test Vectors
The MAT-File test vector offers an easy way for you to use data from a
MAT-file in the SystemTest software.

To add a test vector:

1 Click the New Vector button in the Test Vectors pane.

In the Insert New Test Vector dialog box, select the test vector type of
MAT-File.
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The red border indicating that the element is in an error state is normal,
and will go away once you add file(s) in step 4.

2 Assign a name to the vector in the Name field.

3 Click the Add File(s) button.

4 In the Select MAT-File dialog box, browse for your MAT-file(s). You can
select multiple files at the same time. Only MAT-files can be added. Other
file types produce an error. After selecting the file(s), click the Open button
to bring them into the test vector.
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In the MAT-Files to read table on the General tab, MAT-files that are
checked will be used in the test. Unchecking a file means it will not be
included in the test.

5 Click the Variables tab. All the common variables contained in all the
selected MAT-file(s) you added appear in the table.

Note that the variables are sorted in alphabetical order. If you have
multiple MAT-files, only variables that are common across all files appear
in the table.

Variables that are checked will be used in the test. Unchecking a variable
means it will not be included in the test. In the example above, all variables
except for ans will be used in the test.
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Checking or unchecking the checkbox in the table header will select or
unselect all variables. It is a Select All/Unselect All toggle option.

6 MAT-File test vectors are ungrouped by default. On the Grouping tab,
you can select the Assign test vector to a group option if you want to
group the test vector.

Grouping test vectors is useful for reducing the number of iterations to
execute. It means that the SystemTest software will sequentially combine
values for all grouped test vectors, instead of permuting their values. See
“Creating Grouped Test Vectors” on page 2-5 for more information on
grouped test vectors.

7 Click OK in the Insert Test Vector dialog box.

The new vector appears in the Test Vectors pane.

Important Usage Notes

• If you use multiple MAT-Files in a test vector, only commonly named
variables included in all of the files will be read and used. For example, if
you have variables in MAT-file A called Speed, Distance, and Pressure,
and in MAT-file B you have variables Speed, Pressure, and Torque,
only Speed and Pressure will be shown since they are included in both
MAT-Files. Distance and Torque will not be used since they do not exist
in both files.

• If the order of execution of the MAT-files is important, then use the up and
down arrows to order the files accordingly in the test vector table. Each
MAT-file is one iteration of the test vector, and they are executed in the
order they appear in the table.

• The test vector is evaluated every time the test is run – that means the
data is read from the MAT-File(s) every time the test is run.

• If a MAT-File test vector is mapped to the inport blocks in a Simulink
element using the All Inport blocks are mapped option, the model
is simulated using all the variables that are selected in the Variables
table in the test vector. If it is mapped to the inport blocks using the
Individual Inport blocks are mapped option, the model is simulated
with individually selected variables from the MAT-file.
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• Checking or unchecking the checkbox in the Variables table header will
select or unselect all variables. It is a Select All/Unselect All toggle option.
This option affects the variables selection behavior when you add or remove
or select or unselect MAT-files in the MAT-file list on the General tab.

For example, if the checkbox is selected (to Select All variables) and then a
MAT-file is added/removed or selected/unselected, all common variables
will be selected by default.

If the checkbox is unselected (to Unselect All variables) and then a MAT-file
is added/removed or selected/unselected, all common variables will be
unselected by default.
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Creating Randomized Test Vectors with Probability
Distributions

In this section...

“Using Probability Distributions in Test Vectors” on page 2-18
“Creating a Test Vector with Probability Distributions” on page 2-18
“The Probability Distributions” on page 2-23
“Example: Creating Test Vectors with Probability Distributions” on page
2-31

Using Probability Distributions in Test Vectors
The SystemTest software provides an easy way to generate randomized test
vector values for your test. You can use probability distribution functions to
set up test vectors, which is useful for performing Monte Carlo analyses.

If you have the Statistics Toolbox™ software, the SystemTest software
integrates with it to provide use of some of its probability distribution
functions, such as exponential, gamma, lognormal, T (Student’s t), and
Weibull. If you do not have the Statistics Toolbox software, you can use the
MATLAB probability distribution functions normal (Gaussian) and uniform.

Creating a Test Vector with Probability Distributions
You can use a probability distribution when you create or edit a test vector.
To use a probability distribution:

1 In the Test Vectors pane, click the New Vector button.

2 In the Insert Test Vector dialog box, select Probability Distribution as
the test vector type.

3 Enter a name for the new vector in the Name field.

4 Select a distribution function from the Distribution list.
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If you have the Statistics Toolbox software, all of the functions shown in
the figure appear in the list. If you do not have this toolbox, you can use
normal (Gaussian) and uniform.

For information on the distribution functions, see “The Probability
Distributions” on page 2-23.

5 Once you select a distribution, the relevant options appear. Fill in the
parameters for your distribution.
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For example, normal (Gaussian) allows you to set Mean and Standard
deviation.

6 After setting the relevant probability parameters, type in the Number of
values you want to use. That is the number of values you would like to
generate for the test vector.

TheNumber of valuesmust be a positive integer. It must also be the same
value for all of your probability distributions because the vector is grouped.

7 Select the Evaluate Test Vector each time the test is run option if you
want to use new values every time the test is run. For example, for the
probability distribution, a new set of values for the parameters (such as
Mean) would be calculated each time. Leave it unselected if you want to
use the same values each time the test is run.

If you are doing Monte Carlo testing and you want repeatability of the
data, do not use this option.

8 On the Grouping tab, keep the default of Grouped, or select Ungrouped.
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Randomized test vectors with probability distributions are grouped by
default, as indicated by Grouped being selected.

Grouping test vectors is useful for reducing the number of iterations to
execute. It means that the SystemTest software will sequentially combine
values for all grouped test vectors, instead of permuting their values. In
the case of randomized test vectors, grouping avoids introducing additional
variation into your test. See Creating Grouped Test Vectors for more
information on grouped test vectors.

9 Click OK in the Insert Test Vector dialog box.

The new vector then appears in the Test Vectors pane.
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The Probability Distributions
If you have the Statistics Toolbox software, the SystemTest software
integrates with it to provide use of some of its probability distribution
functions, such as exponential, gamma, lognormal, T (Student’s t), and
Weibull. If you do not have the Statistics Toolbox software, you have access
to the MATLAB probability distribution functions normal (Gaussian) and
uniform.

The SystemTest software supports the distribution functions shown in the
following sections. Select the Probability Distribution test vector type in
the Insert Test Vector dialog box to access the functions.

The Insert Test Vectors dialog box shows fields specific to the distribution you
pick in the list, as shown in the sections below. In each case, enter values for
the function-specific parameters, and then enter the Number of values you
want to generate for the test vector.

Normal (Gaussian)
The normal distribution is a two-parameter family of curves. The first
parameter is the mean. The second parameter is standard deviation. Normal
is often used for data that is symmetrical about the mean.

2-23



2 Working with Test Vectors

Normal uses the function randn and takes parameters for Mean and
Standard deviation. The SystemTest software uses the following
calculation for normal:

mean + Std_Dev * randn(1, #values)

For more information, see randn in the MATLAB documentation.

Uniform
The uniform distribution (also called rectangular) has a constant probability
density function between its two parameters, the minimum and the maximum.

The uniform distribution is appropriate for representing the distribution of
round-off errors in values tabulated to a particular number of decimal places.
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Uniform uses the function rand and takes parameters for Minimum
value and Maximum value. The SystemTest software uses the following
calculation for uniform:

min + (max-min) * rand(1, #values)

For more information, see rand in the MATLAB documentation.

Exponential
The exponential distribution is a special case of the gamma distribution. The
exponential distribution is special because of its utility in modeling events
that occur randomly over time.

Exponential is often used to model the time between independent events that
happen at a constant average rate. For example, you could use it for the
time it takes a radioactive particle decays, or the time between messages
sent over a network.
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Exponential uses the function exprnd and takes one parameter forMean.

For more information, see Exponential Distribution in the Statistics Toolbox
documentation.
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Gamma
The gamma distribution models sums of exponentially distributed random
variables.

Gamma uses the function gamrnd and takes parameters for A and B.

For more information, see Gamma Distribution in the Statistics Toolbox
documentation.
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Lognormal
The normal and lognormal distributions are closely related. The lognormal
distribution is applicable when the quantity of interest must be positive, since
log(X) exists only when X is positive.

Lognormal can be used to model something that can be thought of as the
multiplicative product of many small independent factors. A common
example is the long-term return rate on a stock investment, because it can
be considered as the product of daily return rates.

Lognormal uses the lognrnd function and takes parameters for Mean and
Standard deviation.

For more information, see Lognormal Distribution in the Statistics Toolbox
documentation.
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T
The T (Student’s t) distribution is a family of curves that depend on a single
parameter v (the degrees of freedom). As v goes to infinity, the T distribution
approaches the standard normal distribution.

T is often used to estimate properties when the sample size is small.

T uses the trnd function and takes one parameter for Degrees of freedom.

For more information, see Student’s t Distribution in the Statistics Toolbox
documentation.
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Weibull
The Weibull distribution is an appropriate analytical tool for modeling the
breaking strength of materials. Current usage also includes reliability
and lifetime modeling. The Weibull distribution is more flexible than the
exponential distribution for these purposes.

Weibull uses the function wblrnd and takes parameters for A and B.

For more information, see Weibull Distribution in the Statistics Toolbox
documentation.
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Example: Creating Test Vectors with Probability
Distributions
Many models must take into account the effect of evaluating uncertainty in
model parameters. In this example the tester needs to account for uncertainty
in electric motor characteristics that come off the production line so the
tester defines the model’s parameters as distributions of values, rather than
as single fixed values. The tester then performs a Monte Carlo simulation,
running the model repeatedly with random combinations of parameter values
to account for variability in manufacturing.

In this case, the tester defines the uncertain motor parameters as test vectors.
The test varies parameters for armature resistance, armature inductance,
and shaft inertia.

To create the first vector, for armature resistance:

1 In the Test Vectors pane, click the New Vector button.

2 In the Insert Test Vector dialog box, select Probability Distribution as
the test vector type.

3 Enter ArmatureResistance in the Name field.

4 In the Insert Test Vector dialog box, use the default distribution, normal
(Gaussian).

You do not need to have the Statistics Toolbox software installed to use
normal (Gaussian) since it is included with MATLAB.

5 In the Mean field, enter 1.71.

6 In the Standard deviation field, enter .056.
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7 In the Number of values field, enter 1000.

For this vector, the test is varying armature resistance up to a standard
deviation of .056, around a mean of 1.71, and using 1000 values.

8 Click OK in the Insert Test Vector dialog box.

The new vector appears in the Test Vectors pane.
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To create the second vector, for armature inductance:
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1 In the Test Vectors pane, click the New Vector button.

2 In the Insert Test Vector dialog box, select Probability Distribution as
the test vector type.

3 Enter ArmatureInductance in the Name field.

4 Use the default distribution, normal (Gaussian).

5 In the Mean field, enter .3.

6 In the Standard deviation field, enter .01.
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7 In the Number of values field, enter 1000.

For this vector, the test is varying armature inductance up to a standard
deviation of .01, around a mean of .3, and using 1000 values.

8 Click OK in the Insert Test Vector dialog box.

The new vector appears in the Test Vectors pane.
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To create the third vector, for shaft inertia:
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1 In the Test Vectors pane, click the New Vector button.

2 In the Insert Test Vector dialog box, select Probability Distribution as
the test vector type.

3 Enter ShaftInertia in the Name field.

4 Use the default distribution, normal (Gaussian).

5 In the Mean field, enter 44.5.

6 In the Standard deviation field, enter .443.

2-37



2 Working with Test Vectors

7 In the Number of values field, enter 1000.

For this vector, the test is varying shaft inertia up to a standard deviation
of .443, around a mean of 44.5, and using 1000 values.

8 Click OK in the Insert Test Vector dialog box.

The new vector appears in the Test Vectors pane.
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Creating Spreadsheet Data Test Vectors

In this section...

“Introduction” on page 2-40
“Creating a Spreadsheet Data Test Vector” on page 2-40
“Configuring the Spreadsheet Data Test Vector” on page 2-44
“Replacing Strings” on page 2-47

Introduction
The Spreadsheet Data test vector type can be used to read data from
Microsoft® Excel® files or .csv files into the SystemTest software. This
feature also supports file formats used by the MATLAB xlsread function.

You can read spreadsheet data from multiple sheets, and can read whole
sheets or a subset of a sheet.

For a detailed example using the Spreadsheet Data test vector, see “Example:
Overriding Simulink Inport Blocks Using a Spreadsheet Data Test Vector”
on page 4-28.

Note For additional technical information and limitations of this feature,
see the SystemTest Release Notes.

Creating a Spreadsheet Data Test Vector
To create a Spreadsheet Data test vector:

1 In the Test Vectors pane, click the New button.

2 In the Insert Test Vector dialog box, select Spreadsheet Data as the test
vector type.
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3 On the General tab, click the Add File button.

Browse to your Microsoft® Excel® spreadsheet file or a .csv file and click
Open.

4 The first sheet of your file is selected by default. If the file has multiple
sheets and you want to use them, select the other sheet(s). There is no limit
to the number of sheets you can use.

5 Select the Evaluate Test Vector each time the test is run option if you
want to read the file every time the test is run. Leave it unselected if you
want to use the same values each time the test is run.
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In the case of a Spreadsheet Data test vector, using this option means that
data would be read from the spreadsheet file every time the test is run. If
you expect the data to change and want to have it read every time, select
this option. If you know the data is static or you do not want it to be read
each time, unselect the option.

Note that you can use the Evaluate button in the Test Vectors pane any
time for an immediate evaluation.

6 On the Data Selection tab, choose the range to use in the test vector.
Enter this information in the Data Range section to select the range.

Specify whether your data is arranged by column or row using the Data is
arranged by option.

Then select the specific range using the Read data from option. For
example, if you have a file that has data in columns A, B, and C, and there
is data in rows 3 through 13 and you want to read all the data, in the Read
data from column option, fill in A to C. Then in the starting at row
option, enter 3. The SystemTest software will read to the end of the data.

All data in the designated columns is read, from the start-at row through
the end of data. Therefore you should only put data in the columns that you
want to be read. Extraneous data should be removed if you do not want it to
be read. Any blank cells within the read data range will be treated as NaN.

If the first row of your sheet is a header, you can select the First row is a
header option to have the SystemTest software exclude it from the data.

7 In the For Each Selected Sheet section, select the option to determine
how the data is arranged when the vector is created. You can have each
row (or column) of the spreadsheet be a separate test vector value, or you
can have the entire sheet be one test vector value.
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See “Configuring the Spreadsheet Data Test Vector” on page 2-44 for more
information about these two options.

8 You can optionally replace strings in the file with values using the String
Replacement tab. The table is automatically populated with any strings
contained in your sheet(s). If you want to replace each occurrence of a
particular string with a value, type the value in the Value column of the
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table. Then when the test vector is evaluated, that string will be replaced
with the value you indicated to populate the test vector.

See “Replacing Strings” on page 2-47 for more information about this option.

9 Click OK in the Insert Test Vector dialog box. The new vector then appears
in the Test Vectors pane.

After creating a Spreadsheet Data test vector, you can edit it any time by
selecting it in the table in the Test Vectors tab. If you make any changes to
the configuration of the test vector in the SystemTest software, they will be
applied immediately. If you make any changes to the underlying spreadsheet,
you can have the data reread by clicking the Evaluate button above the
test vectors table.

For a detailed example using the Spreadsheet Data test vector, see “Example:
Overriding Simulink Inport Blocks Using a Spreadsheet Data Test Vector”
on page 4-28.

Note If the data in your spreadsheet is numeric, it will be a double array in
the test vector. If the data contains any strings, it will be a cell array. If the
data contains header information and you specified the first row as a header,
that will be excluded, and if the remaining data is numeric, it’s treated as a
double array.

Configuring the Spreadsheet Data Test Vector
As shown in step 7 in “Creating a Spreadsheet Data Test Vector” on page
2-40, you can configure test vector values using the Data Selection tab when
you create or edit a Spreadsheet Data test vector.

In the For Each Selected Sheet section, you select the option to determine
how the vector is created. You can have each row (or column) of the
spreadsheet be a separate test vector value, or you can have the entire sheet
be one test vector value.
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Treat each row as a test vector value

The Treat each row as a test vector value option means that each row
or column (depending on what you selected in the Data is arranged by
option) is one test vector value.

In the first case shown here, column A contains values for the parameter
Gain. Suppose this column contains 10 values, in rows 2 through 11 (row 1 is
a header). The resulting test vector would be a 1-by-10 array containing 10
values. The first value is 1, the second value is 1.1, etc. The ten populated
rows result in a total of ten values, each row being one scalar value.

The same is true of the second example shown — that each row is a separate
value, except that in this case each value is an array, instead of a single
scalar. The first test vector value in this case is the array [1 2 1]. The
second test vector value is [2 4 4], etc. If this sheet also had ten rows, there
would be ten separate values (each an array of 3 numbers) and the test
vector length would be 10.
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Treat each selected sheet as a test vector value

The Treat each selected sheet as a test vector value option means that
each entire sheet is one test vector value.

If the sheet contains multiple rows and columns, the resulting test vector
value is a matrix. In the first example shown here, labeled Simulink Signals,
this spreadsheet file contains 3 sheets. Suppose each sheet contained the
three columns shown, t, u1, and u2, and had just the three rows of values
shown. The resulting test vector would be of length 3 since each sheet is
one test vector value and there are three sheets, and each of the three test
vector values would be a 3-by-3 matrix.

Suppose the second example, labeled MATLAB Matrix, contained five sheets
and each sheet had the three columns shown, each with ten rows of data. The
resulting test vector would be of length 5 since each sheet is one test vector
value and there are five sheets, and the five test vector values would each be a
10-by-3 matrix, since the sheets have ten rows of data and three columns.

Configuring each sheet to be one test vector value can be useful in a case
where you have a test case in each sheet, and each test case is a matrix.
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Using Multiple Sheets

If you configure a test vector to use multiple sheets in a file, and you use the
Treat each row as a test vector value option, each sheet is read, turned
into individual rows, and then appended together. For example, if your file
has three sheets containing three, four, and five rows of data respectively, the
resulting test vector is a set of row vectors as follows:

row 1 from sheet 1
row 2 from sheet 1
row 3 from sheet 1
row 1 from sheet 2
row 2 from sheet 2
row 3 from sheet 2
row 4 from sheet 2
row 1 from sheet 3
row 2 from sheet 3
row 3 from sheet 3
row 4 from sheet 3
row 5 from sheet 3

If you configure a test vector to use multiple sheets in a file, and you use the
Treat each selected sheet as a test vector value option, the resulting test
vector will have the same number of values as there are sheets in the file. The
same file with three sheets would have three values:

sheet 1
sheet 2
sheet 3

Replacing Strings
As shown in step 8 in “Creating a Spreadsheet Data Test Vector” on page 2-40,
you can optionally replace strings in the data you read from your spreadsheet
files with values using the String Replacement tab when you create or edit
a Spreadsheet Data test vector. The table lists any strings contained in your
sheet(s), excluding headers if you’ve specified they are present.

If you want to replace each occurrence of a particular string with a value, type
the value in the Value column of the table. Then when the test is run, that
string will be replaced with the value you indicated to create the test vector.
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An example use case for this feature is that you could have a spreadsheet that
contains values for switches, and the values are designated by the strings
ON and OFF.

In this example, you might want to replace each instance of ON with a 1 and
each instance of OFF with a 0. The String Replacement tab of the Insert
Test Vector dialog box would look like the following:

If you want to map the same strings to different values, you have to create
separate test vectors and do each replacement mapping separately. For
example, in the previous case, you might want the values for Switch A to map
to 1 and 0 as shown, but for Switch B you might want to use 100 and 0. In
this case, create a test vector that reads only column A and replace ON and
OFF with 1 and 0, and then create a second test vector for column B that
maps Switch B values to 100 and 0.
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Creating Simulink Design Verifier Data File Test Vectors

In this section...

“Prerequisites” on page 2-49
“Automatically Creating a SystemTest Test Harness from Simulink® Design
Verifier” on page 2-49
“Creating a Simulink Design Verifier Data File Test Vector” on page 2-51
“Important Usage Notes” on page 2-61

Prerequisites
The Simulink Design Verifier Data File test vector can read test cases created
by the Simulink® Design Verifier™ software. In order to use this test vector,
you need a Simulink Design Verifier data file with test cases.

To use this feature, you first run Simulink Design Verifier with the
appropriate configuration. Then you can do one of two things:

• Generate a SystemTest harness for the model from Simulink. When it
completes, a new test opens automatically in SystemTest and a Simulink
Design Verifier Data File test vector is automatically created. This
workflow is described in “Automatically Creating a SystemTest Test
Harness from Simulink® Design Verifier” on page 2-49.

• If you already have a data file from Simulink Design Verifier, you can create
a test vector in SystemTest that uses the test cases in the data file, and
configure overrides in a Simulink element. This workflow is described in
“Creating a Simulink Design Verifier Data File Test Vector” on page 2-51.

Automatically Creating a SystemTest Test Harness
from Simulink Design Verifier
If you generate a SystemTest test harness from Simulink using Simulink
Design Verifier, a new test opens automatically in SystemTest with a
Simulink Design Verifier Data File test vector and a Simulink element
automatically created for you. The following steps outline this workflow.

1 From your model, select Tools > Design Verifier > Options.
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2 In the Configuration Parameters dialog box, select Design Verifier
> Results, and then enable the Save test harness as SystemTest
TEST-file option.

3 Click OK.

4 In Simulink, save the model.

5 From your model, select Tools > Design Verifier > Generate Tests to
run the model and generate the SystemTest test harness.

After the model generates test cases, the SystemTest software opens
automatically. A Simulink Design Verifier Data File test vector containing
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the generated test inputs is automatically created. A Simulink element
is also created, configured with the model name, override mappings set,
and model coverage enabled.

6 Optionally, in the SystemTest software, you can add other things to the
test, such as a plot element. For an example of this, see “Creating a
Simulink Design Verifier Data File Test Vector” on page 2-51.

7 Run the test in the SystemTest software by clicking the Run button.

Creating a Simulink Design Verifier Data File Test
Vector
If you already have a data file from Simulink Design Verifier, you can create a
test vector in the SystemTest software that uses the generated rest cases in
the data file, and configure overrides in a Simulink element. The following
steps outline this workflow.

1 In the Test Vectors pane, click the New button.

2 In the Insert Test Vector dialog box, select Simulink Design Verifier
Data File as the test vector type.
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3 Accept the default test vector name, or type a new one in the Name field.

4 Type the name of the Simulink Design Verifier data file in the Type field,
or use the Browse button to locate it. It will be a .mat file.

Note that you must use a valid MAT-file – a Simulink Design Verifier data
file created in version R2008b or later. If you try to use a data file created
in an earlier version of the software or a MAT-file that is not generated
from Simulink Design Verifier, you will get an error.
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5 When the data file is read in, the test cases appear in the Test Cases Name
table. Click any test case to see its test case description below the table.

6 To see information from the Simulink Design Verifier data file, click the
Details tab. This provides analysis information on the data file, and the
model Inport blocks associated with the test cases. If the test cases involve
any model parameter configurations, they appear in the Parameters
section. This section will list any parameters that are used as part of a test
case. The information in this tab is not editable.
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7 Click the OK button to finish creating the new test vector. It then appears
in the Test Vectors pane in the SystemTest desktop.

Now that the test vector is created, you can create mappings in a Simulink
element.

8 Create a Simulink element by clicking the Main Test node in the Test
Browser, and clicking the New button. Select Test Element > Simulink.
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9 Type the name of the model, or use the Browse button to locate it. This
should be the same model that was used to create the Simulink Design
Verifier data file.

If you browsed for the file, when you click OK, the model opens.

10 In the Override Inport Block Signals with SystemTest Data section
of the Simulink element, select the All Inport blocks are mapped using
option. You must select this option in order to correctly use the Simulink
Design Verifier data file.

11 From the drop-down list, select the test vector you created earlier in this
workflow.
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In the example shown here, the model name is
sldvdemo_cruise_control.mdl and the vector is TestVector1.
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12 If you have the Simulink® Verification and Validation™ software and you
want to use the Model Coverage feature in the Simulink element, click
the Model Coverage tab.

13 Select the Enable Model Coverage check box.

14 Select Override model coverage metric settings.

15 Select any metrics you want to cover in the Coverage Metrics section.
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16 Optionally, if you want to plot any of the signals, create a plot element.
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Select the Simulink element you already created in the Test Browser, and
select New > Test Element > Plot – General.

17 In the Plot element, click the Add Plot button.

18 Select Simulink Data.

19 From the Simulink Data field, expand the test vector that you created to
see the individual signals.
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20 Select one of the signals, for example, speed.

21 Run the test by clicking the Run button on the SystemTest toolbar.

In this example, after the test runs, a model coverage report and a plot
of the speed signal are generated.

Important Usage Notes
The following notes pertain to the integration between the SystemTest
software and Simulink Design Verifier using the Simulink Design Verifier
Data File test vector:

• Model Coverage Report — The model coverage report generated by
the model harness using Simulink Verification and Validation and that
of the SystemTest harness generated by Simulink Design Verifier will
be identical.

• Data Format — The format of the data from a Simulink Design Verifier
Data File test vector, if seen in a MATLAB element or in saved test results
for example, is a subset of the Simulink Design Verifier data format.

It is a MATLAB structure with one field, TestCases. Then the TestCases
field contains two fields, dataValues and paramValues. TestCases is a
1x1 structure. The following figure shows the data format for a Simulink
Design Verifier Data File test vector called TestVector1:
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• Data file Version — To use the Simulink Design Verifier Data File test
vector, you must use a Simulink Design Verifier data file created in version
R2008b or later. If you try to use a data file created in an earlier version
of the software or a MAT-file that is not generated from Simulink Design
Verifier, you will get an error.

• Evaluating the Test Vector — If you make changes in the underlying
Simulink Design Verifier test cases, you can click the Evaluate button
in the Test Vectors pane any time to see the changes reflected in the
SystemTest user interface. However this is not necessary to pick up
the changes for running the test. When you run a test containing a
Simulink Design Verifier Data File test vector, the SystemTest software
automatically queries the data file for the latest information in the test
cases.

• Changing the Underlying Model — If you make changes in the
underlying Simulink model, such as changes to Inport blocks, you should
return to Simulink Design Verifier and regenerate the test cases and the
test harness. Then return to SystemTest test harness to continue working
with your test.

• Model End Time — In the use case where you automatically generate
the SystemTest test harness from Simulink Design Verifier, the end time
used will be that of the test cases per iteration. However, in the use case
where you create the test vector in SystemTest using a Simulink Design
Verifier data file that you already have, the underlying model’s end time
will be used per iteration.

• Bus Support — The Simulink Design Verifier Data File test vector
supports the use of busses in Inport blocks. Bus support is only available in
SystemTest through this feature.
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Creating Signal Builder Block Test Vectors
If you have created a Simulink model test harness using a Signal Builder
block, you can automate the running of all your test cases by integrating them
into a SystemTest test. This also offers the ability to collect cumulative model
coverage metrics for all your Signal Builder test cases.

The most common workflow for this feature is to create a Simulink element
and then create the test vector from within the element, as follows:

1 In the SystemTest desktop, create a Simulink element by clicking the
Main Test node in the Test Browser, and clicking the New button. Select
Test Element > Simulink.

2 Type the name of the model, or use the Browse button to locate it. This
should be the model that includes the Signal Builder block whose test cases
you are interested in.

When you click OK, the model opens.

This example uses the model systemtestsfcar.

3 In the Simulink element, click the up arrows in the banner of the Override
Inport Block Signals with SystemTest Data section to close it.

4 Click the down arrows in the banner of the Run Signal Builder test
cases from SystemTest section to expand it.

5 Enable the Signal Builder test cases by selecting the Use test vector
check box.
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6 Click the down arrow and select <New Signal Builder Block test
vector...>.

7 The Insert Test Vector dialog box opens and Signal Builder Block is
the selected test vector type.

Keep the default test vector name or type a new one.

8 On the General tab, type the name of the model you used in the Simulink
element, or click the Browse button to locate it.
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Note You cannot use a Signal Builder Block test vector with a Simulink
element that uses a different model. You must refer to the same model in
both the test vector and the Simulink element.
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9 When the model is found, the Signal Builder test cases appear in the Test
Cases section.

If there are any test cases you do not want to test, you can disable them
using the check boxes. Test cases that are checked will be tested.

10 You can click the Test Signals tab to view the test signals associated with
your Signal Builder block.
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11 Click OK to finish creating the test vector.

12 To view or edit the test vector after it is created, click the Test Vectors tab
in the SystemTest desktop.

13 Optionally create other elements, test vectors, variables, or saved results,
and run your test.

Note If you make changes in the underlying Signal Builder block in your
model, you can click the Evaluate button in the Test Vectors pane any
time to see the changes reflected in the user interface. However this is not
necessary to pick up the changes for running the test. When you run a test
containing a Signal Builder Block test vector, the SystemTest software
automatically queries the model for the latest information in the Signal
Builder block.

Note When you run the test, the Signal Builder test cases are run in the
order in which they appear in the Signal Builder block in your model. This
same order is reflected in the Test Vectors pane in the SystemTest software,
unless you change the order in the table by sorting the columns.
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Note You may have tested a Signal Builder block in previous SystemTest
versions by using the Override Block Parameters with SystemTest Data
section of a Simulink element. In that scenario you would create a new
mapping to the Signal Builder block.

However, using the Run Signal Builder test cases from SystemTest
section in the Simulink element and creating the Signal Builder Block test
vector is a better and easier solution. Because the Signal Builder test cases are
in a test vector, you can do more with them, such as plotting. Also, the signals
are stored in the SystemTest results set, rather than the index of the test case.

Note that if you have a Simulink element that contains the mappings from
the former way of including a Signal Builder block, and then you use the new
Signal Builder Block test vector and use the new section in the same Simulink
element, the test will use the new information in the Run Signal Builder
test cases from SystemTest section in the Simulink element.
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Editing a Test Vector from within an Element
If you want to edit a test vector while working within an element, you can
open the editor by right-clicking on the name of the test vector in the table(s)
on the Properties tab of some of the elements. This feature is included in
the following elements:

• Limit Check – General Check

• Limit Check – Tolerance Check

• Simulink

• General Plot
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Working with the Sections of a Test

In this section...

“Overview” on page 3-2
“Pre Test” on page 3-2
“Main Test” on page 3-3
“Post Test” on page 3-3

Overview
Each section of the test serves a different purpose and has different properties
that can be set in the Properties pane. Click a part of the test or an element
in the Test Browser to see the properties for that section or element.

The descriptions of the elements in this chapter include a list of which sections
of the test you can use each element in. The following sections describe the
sections of a test. They are followed by a description of how to use the basic
elements.

Pre Test
The Pre Test runs once prior to any number of iterations through Main Test.
Pre Test can be used to perform general test setup such as:

• Opening a model.

• Initializing variables.

• Accessing system resources, such as opening a file.

• Initializing external test equipment.

In Pre Test, only test variables defined as a Pre Test variable may be modified
or assigned to. Pre Test variables are initialized during Pre Test and persist
throughout the Main Test and Post Test.

In Pre Test you can add the following element types: Simulink, MATLAB,
Subsection, Stop, IF, Video Input, the three Instrument Control Toolbox
elements, and the four Data Acquisition Toolbox elements.
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With Pre Test you can initialize Pre Test variables and run elements that you
only want to run once before any Main Test iterations. For example, you can:

• Add a Simulink element to run a model and assign baseline data to a Pre
Test variable.

• Add a MATLAB element to load a MAT-file or perform some other test
setup.

• Create conditions with the IF element and follow up with a Subsection
element to define what to do when those conditions are met.

Main Test
The Main Test is run one or more times based on the number of iterations.
It is used to:

• Execute elements multiple times in order to perform batch testing or sweep
through a parameter space.

• Perform batch testing or parameter sweeps that require multiple
independent iterations using different test conditions for each iteration.

The number of iterations is defined by the number and length of test vectors
you specify. The SystemTest software executes Main Test once for each
permutation of values in the test vectors specified.

In Main Test you can add all of the element types.

Post Test
The Post test runs once after all Main Test iterations have executed or when
a run-time error occurs in Pre Test or Main Test. Post Test can be used to
perform test cleanup, such as:

• Closing a model.

• Cleaning up your workspace.

• Releasing system resources, such as closing a file.

• Returning external test equipment to a safe state.
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In Post Test you can add the following element types: MATLAB, Subsection,
IF, Video Input, the three Instrument Control Toolbox elements, and the four
Data Acquisition Toolbox elements.
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Basic Elements

In this section...

“Introduction” on page 3-5
“MATLAB Element” on page 3-6
“Limit Check Element — General Check” on page 3-7
“Limit Check Element — Tolerance Check” on page 3-11
“IF Element” on page 3-14
“General Plot Element” on page 3-15
“Vector Plot Element” on page 3-20
“Scalar Plot Element” on page 3-22
“Stop Element” on page 3-24
“Subsection Element” on page 3-25

Introduction
The sections listed above describe how to work with the basic elements.

The Simulink element is covered in detail in Chapter 4, “Using the Simulink
Element”. The hardware elements are covered in detail in “Introduction” on
page 7-2 in Using the Image Acquisition Toolbox Element, “Introduction” on
page 6-2 in Using the Data Acquisition Toolbox Elements, and “Introduction”
on page 5-2 in Using the Instrument Control Toolbox Elements.

To see the MATLAB, Limit Check, and Scalar Plot elements used in an
example, see “Adding Elements” on page 1-20.

Tip You can rename any element or subsection by double-clicking its name
in the Test Browser.
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Invalid Characters in Element Names
The following characters are invalid to include within element names:

• ’

• <

• >

You cannot use these three characters in element names. If you create a new
test element with one or more of these characters in the element name, then
the SystemTest software throws an error dialog and the element name is
reset to the default value, which is the name of the element type.

If you try to load an existing test with an invalid element name (containing
one or more of the three characters listed above), the SystemTest software
displays an error dialog indicating that the element name is invalid. The test
will load successfully, but the element with an invalid name is reset to use the
default name for the element. If this occurs, simply rename the element to a
name that does not contain any of the invalid characters.

MATLAB Element
The MATLAB element lets you run MATLAB scripts from within a test.
In addition to specifying any valid MATLAB script to execute, you can
incorporate any test variable into your code, as well as access any variables
residing in the MATLAB workspace.

Allowed Test Sections
The MATLAB element can be used in the following test sections:

• Pre Test

• Main Test

• Post Test
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Properties Pane
In the MATLAB Script edit field, enter any valid MATLAB script.

Limit Check Element — General Check
The General Check tab of the Limit Check element determines test
conditions are met by using scalar, vector, or matrix comparisons. It can be
used to:

• Compare measured data to expected data.

• Stop an iteration or an entire test if a test constraint is violated.

• Assign a test variable the logical value derived from the comparison(s)
for use by other elements.

You can do the following types of comparisons with the General Check tab
of the Limit Check element:

• Scalar versus scalar

• Scalar versus vector

• Vector versus vector

• Matrix versus matrix
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Note Use the Tolerance Check tab of the Limit Check element to test
absolute and relative tolerance.

Allowed Test Sections
The Limit Check element can be used in the following test section:

• Main Test
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How to Use

1 Click the New button on the General Check tab to add a general limit
check.

• Select an existing test variable or create a new one in the Test Variable
column.
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• Select an operator in the Operator column.

• Select an existing test variable or test vector or create a new one in the
Limit column.

2 Set your test’s passing conditions.

• The element can pass if all comparisons complete successfully (a logical
AND).

• The element can pass if one or more of the comparisons complete
successfully (a logical OR).

3 Set your fallback procedure if the element fails. You can:

• Allow the current iteration to continue executing.

• Stop the current iteration and proceed to the next iteration.

• Stop the test and proceed to Post Test.

4 Identify the SystemTest test variable you want to assign the logical value
derived from the comparison(s) in the Assign data to field.

Note Aside from setting limit checks on individual elements, you can set
these properties for the entire test, reachable by clicking the test name in the
Test Browser, to determine pass/fail criteria for the test as a whole.

Properties Pane — General Check
You can set the following properties for the Limit Check element:

• Test Variable— Value to compare to limit using operator.

• Operator— Boolean operator used to compare test variable to limit.

• Limit— Value to compare to test variable using operator.

• For this element to pass — Choose between a logical AND (all
comparisons must pass) or a logical OR (at least one comparison needs to
pass) for the element to pass.

• If this element fails— Choose between continuing the test, stopping the
current iteration, or stopping the entire test.
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• Assign data to — Test variable assigned the logical value of this
evaluation. The logical value will be 1 if the element passes or 0 if the
element fails.

Limit Check Element — Tolerance Check
The Tolerance Check tab of the Limit Check element verifies test conditions
are met by using absolute and relative tolerance comparisons. It can be
used to:

• Compare measured data to expected data.

• Stop an iteration or an entire test if a test constraint is violated.

• Assign a test variable the logical value derived from the comparison(s)
for use by other elements.

• Define pass/fail criteria for an iteration.

You can do the following types of comparisons with the Tolerance Check tab
of the Limit Check element:

• Absolute tolerance

• Relative tolerance

For a definition of these tolerance types, see the Properties Pane section.

Note Use the General Check tab of the Limit Check element to test scalar,
vector, and matrix comparisons.

Allowed Test Sections
The Limit Check element can be used in the following test section:

• Main Test
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How to Use

1 Click the New button on the Tolerance Check tab to add a tolerance
limit check.

• Select an existing test variable or create a new one in the Test Variable
column.
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• Select an existing test variable or test vector or create a new one in the
Expected Value column.

• Select Absolute or Relative in the Tolerance Type column.

• Select an existing test variable or test vector or create a new one in the
Tolerance Limit column.

2 Set your test’s passing conditions.

• The element can pass if all comparisons complete successfully (a logical
AND).

• The element can pass if one or more of the comparisons complete
successfully (a logical OR).

3 Set your fallback procedure if the element fails. You can:

• Allow the current iteration to continue executing.

• Stop the current iteration and proceed to the next iteration.

• Stop the test and proceed to Post Test.

4 Identify the SystemTest test variable you want to assign the logical value
derived from the comparison(s) in the Assign data to field.

Note Aside from setting limit checks on individual elements, you can set
these properties for the entire test, reachable by clicking the test name in the
Test Browser, to determine pass/fail criteria for the test as a whole.

Properties Pane — Tolerance Check
You can set the following properties for the Limit Check element.

• Test Variable — Variable to compare with expected value using a
tolerance limit.

• Expected Value — Expected value to compare variable to using a
tolerance limit.

• Tolerance Type — Tolerance type used to compare test variable to the
expected value. Select Absolute or Relative. Absolute tolerance is
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calculated using this formula: abs(test variable - expected value)
<= tolerance limit. Relative tolerance is calculated using this formula:
abs(test variable - expected value) <= tolerance limit.*
abs(expected value).

• Tolerance Limit — Value used as the tolerance constraint to compare
variable and expected value.

• For this element to pass — Choose between a logical AND (all
comparisons must pass) or a logical OR (at least one comparison needs to
pass) for the element to pass.

• If this element fails— Choose between continuing the test, stopping the
current iteration, or stopping the entire test.

• Assign data to: — Test variable assigned the logical value of this
evaluation. The logical value will be 1 if the element passes or 0 if the
element fails.

IF Element
The IF element provides logical control of a test by evaluating a condition.

The IF element allows sub-elements to run only when the IF element’s
condition evaluates to true. After adding an IF element, you should add one
or more elements to perform a specific task.
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Allowed Test Sections
The IF element can be used in the following test sections:

• Pre Test

• Main Test

• Post Test

Properties Pane
You can set the following property for the IF element.

• Condition — Enter a valid MATLAB expression that will evaluate to
true or false.

General Plot Element
The General Plot element is used to plot any type of data over multiple
iterations.

Use this element during the Main Test to generate plots of any test vectors or
test variables containing any type of data.
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Allowed Test Sections
The General Plot element can be used in the following test section:

• Main Test
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General Tab
To add a plot:

1 Click the Add Plot button to create a plot.

2 From the drop-down list, select one of the following:

• plot— A standard line plot that uses a 2-D line graph with linear axes.

• Simulink data— Lets you plot data produced from a Simulink model.
The supported data types are such [time signal] array, a structure, a
structure with time, or a time series. Note that the element creates a
line for each signal in the Simulink data. If time is not present, the
signals are plotted against their indices.

You can also plot Simulink data provided by test vectors, such as the
Signal Builder Block test vector, the Simulink Design Verifier Data File
test vector, or the Spreadsheet Data test vector.

• bar — A standard bar plot that creates a bar graph.

• scatter — A standard scatter plot that creates a 2-D scatter graph
displaying markers at x- and y-coordinates.

• contour — A standard line plot that creates a 3-D contour graph
displaying isolines of a surface in a 3-D view.

• imagesc — An image plot with colormap scaling, which displays an
image and scales it to use the full colormap.

• surf — A standard surface plot that creates a 3-D surface plot that
displays a matrix as a surface.

• mesh— A standard surface plot that creates a 3-D mesh plot displaying
a matrix as a wireframe surface.

• More plots — Opens the Choose Plot Type dialog box, which lets you
choose any MATLAB plot. Select a plot type category in the Categories
list to display the plot types from the Plot Types list. Select an
individual plot type to read the Description.

Add Axes Button
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You can have multiple axes in a plot figure. To add an axes, click the Add
Axes button. Then click the Add Plot button to create the plot for that axes.
Each axes is added as a subplot to the parent figure.

You can set properties for each axes individually by selecting the axes and
then configuring properties in the Properties area. With the axes selected,
you can configure the X and Y labels and add a title and legend. With the plot
under the axes selected, you can configure the plot.

Properties

When the Figure node is selected or you have not yet added a plot, the Figure
name field is displayed. Optionally use this text field to name the plot.

When you select a plot type and it is added to the tree, the Properties section
displays the properties of that plot type. Fill in any parameters you want to
set. For more information on the parameters, see the help in the Choose Plot
Type dialog box when you select More Plots.

When you select an axes the axes properties are displayed. Use the X label
and Y label fields to enter names for the X and Y axes. Use the Title field to
enter a title for the plot. If you select the Include legend option, a legend
is added to the plot. The legend is located in the least used space outside of
the plot.

You can set other options for the General Plot element by clicking the
Options tab.

Plotting Simulink Data
You can plot data produced from a Simulink model. The supported data types
are such [time signal] array, a structure, a structure with time, or a time
series. Note that the element creates a line for each signal in the Simulink
data. If time is not present, the signals are plotted against their indices.

You can also plot Simulink data provided by test vectors, such as the Signal
Builder Block test vector, the Simulink Design Verifier Data File test vector,
or the Spreadsheet Data test vector.

The Simulink data types are plotted as follows:
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• For an array, it is plotted against its indices.

• For a structure in the format generated by a Simulink Outport, its signal
values are plotted against its indices.

• For a structure with time in the format generated by a Simulink Outport,
its signal values are plotted against its time.

• For a structure with time in the format generated by the Signal Builder
Block test vector, its signal values are plotted against its time.

• For a Simulink.Timeseries object, the plot is determined by the plot()
function of the Simulink.Timeseries object.

Options Tab
These options control the test behavior pertaining to plots.

The Each time the element executes option determines run-time behavior
of the element.
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• Clear the figure of any previous iteration’s data – Every time the
element executes, the figure is cleared before plotting new data. This is
the default.

• Keep any existing data on the figure – Previous plots are not removed
from the figure. New data is added to the same figure.

The If this test is generating a report option determines what happens to
the snapshots of the plots that are created when each iteration runs.

• Put a snapshot of the figure into the report each iteration – A
snapshot of the plot is generated in each iteration and is displayed in its
respective section of the report. This is the default.

• Put a snapshot of the figure into the report at the end of the test –
Only one snapshot of the plot is taken, at the end of the completed test run.
It is displayed in the report section for Post Test.

• Do not put any snapshots into the report – No snapshots of plots are
added to the report.

Vector Plot Element
The Vector Plot element is used to plot array or vector data over multiple
iterations.

Use this element during the Main Test to generate plots of any test
variables containing array or vector data. You can change the number of
iterations displayed to as many as 16 (in a 4-by-4 matrix) using the Subplot
Dimensions fields. The default is one iteration.
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Allowed Test Sections
The Vector Plot element can be used in the following test section:

• Main Test
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Plot Type
Choose one of the following plot types:

• plot — Standard plot of X and Y.

• semilogx— Semilogarithmic plot with logarithmic X-axis.

• semilogy— Semilogarithmic plot with logarithmic Y-axis.

• loglog — Log-log scale plot.

• stem — Lines extending from a baseline along the X-axis.

Properties Pane
You can set the following properties for the Vector Plot element.

• X Axis — Choose a test variable to use for an X-axis value.

• Y Axis— Choose a test variable to use for a Y-axis value.

• Line Color— Select a color to use for the line between each data point.

• Line Style— Set the type of line to be drawn between each data point.

• Line Marker— Choose a symbol to represent each data point.

Subplot Dimensions

• Rows— The number of rows you want displayed in the Subplots window.

• Columns — The number of columns you want displayed in the Subplots
window.

• Clear axes between iterations— Applies only when you have one row
and one column to display. Selecting this option (default) rewrites the
plot with new data during each iteration. Clearing this option adds new
data to the plot during each iteration.

Scalar Plot Element
The Scalar Plot element is used to plot scalar data for each iteration.

Use this element during the Main Test to generate a plot of one or more
scalar test variables.
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Allowed Test Sections
The Scalar Plot element can be used in the following test section:

• Main Test

Plot Type
Choose one of the following plot types:

• plot — Standard plot of X and Y.

• semilogx— Semilogarithmic plot with logarithmic X-axis.

• semilogy— Semilogarithmic plot with logarithmic Y-axis.

• loglog — Log-log scale plot.

• stem — Lines extending from a baseline along the X-axis.
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Properties Pane
You can set the following properties for the Scalar Plot element.

• Maximum Number of Points to Display at Once — Determine how
many points to show simultaneously. By default this is infinite such that
all points will be plotted. Use a MATLAB numeric that evaluates to a
positive, nonzero integer to set this field’s value.

• X Axis — Choose a test variable to use for an X-axis value.

• Y Axis— Choose a test variable to use for a Y-axis value.

• Line Color— Select a color to use for the line between each data point.

• Line Style— Set the type of line to be drawn between each data point.

• Line Marker— Choose a symbol to represent each data point.

Stop Element
The Stop element stops an iteration or an entire test unconditionally.

You can use the Stop element with conditional logic elements, such as the IF
element, to control the test’s execution.

Allowed Test Sections
The Stop element can be used in the following test sections:

• Pre Test

• Main Test
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Properties Pane
You can set the following properties for the Stop element.

• When this element runs— Select a stop action for use in Main Test. The
Current iteration stops option stops the current Main Test iteration. The
All testing stops option stops all Main Test iterations and runs Post Test.

Note that when a Stop element is used in Pre Test, All testing stops is the
only option, since Pre Test does not have iterations.

• Display Message— Enter a message to display in the Test Report.

Subsection Element
Use subsection elements to organize one or more elements to maintain
readability of your test or to better manage complex test structures. Use
a subsection to:

• Group elements under a single root element.

• Organize tests.

• Manage complex test structures.
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Allowed Test Sections
The Subsection element can be used in the following test sections:

• Pre Test

• Main Test

• Post Test

Properties Pane
You can set the following properties for the Subsection element.

• Description — Type in your description of the subsection.
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4

Using the Simulink
Element

The Simulink element allows you to override the inputs to a Simulink model
with SystemTest test vectors and test variables. You can further map the
model’s outputs to SystemTest test variables for later processing by other
test elements. This means that you can use the SystemTest software to
define, generate or load input data, feed it into Simulink, run the model while
iterating over the input data, and map the outputs back into the SystemTest
software.

Note To use the Simulink element, you must have a license for Simulink.

• “Before You Begin” on page 4-2

• “Mapping Test Vectors and Test Variables to a Simulink Model” on page 4-4

• “Overriding Inport Block Signals” on page 4-22

• “Using Simulink Model Coverage” on page 4-38

• “Using Simulink® Design Verifier Data Files in a Test” on page 4-45

• “Using Signal Builder Block Test Cases in a Test” on page 4-46

Note In Simulink elements, you cannot have more than one model with the
same name. Each model referenced within a test must have a unique name.
If you ran a test containing two models with the same name, the SystemTest
software would only use one of the models.
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Before You Begin
This chapter explains the Simulink setup by having you recreate the Simulink
element that is part of the Inverted Pendulum demo. Before continuing, you
should load this demo from MATLAB and delete the Simulink element from
the demo.

The following steps describe how to do this:

1 Start MATLAB.

2 Open the Inverted Pendulum demo.

a Select Start > Demos to open the Help browser.

b Expand theMATLAB list from the left frame of the browser.

c Select SystemTest. The SystemTest demos open in the right browser
frame.

d Click “Simulink - Mapping and Overriding Simulink Data Using an
Inverted Pendulum Model.” An overview of the demo opens.

e Click the link “Open the demo in the SystemTest Desktop” at the bottom
of the page.

Alternatively, you can enter the following command at the MATLAB
command line:

systemtest InvertedPendulum

The SystemTest desktop opens with the Inverted Pendulum demo loaded.

3 Click the Simulink element in the Test Browser.
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4 Click the Delete element button in the Test Browser button bar or press
the Delete key.
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Mapping Test Vectors and Test Variables to a Simulink
Model

In this section...

“Introduction” on page 4-4
“Adding a Simulink Element” on page 4-5
“Specifying the Simulink Model” on page 4-6
“Overriding Simulink Model Inputs” on page 4-6
“Mapping Simulink Model Outputs to Test Variables” on page 4-13
“Using the Model Output Mappings Assistant” on page 4-20
“Editing a Test Vector or Test Variable from within the Element” on page
4-21

Introduction
To help you learn how to use the Simulink element, this section walks you
through the configuration of the Simulink element for the Inverted Pendulum
test. The Inverted Pendulum demo includes both a model of the pendulum
and a model of a controller that keeps the inverted pendulum balanced.
Moving the bottom of the pendulum disturbs the equilibrium, causing the
pendulum to move and the controller to rebalance it. The Inverted Pendulum
test varies the mass of the pendulum, the mass of the cart the pendulum is
on, and the distance to the pendulum’s center of mass, testing the robustness
of the controller as it attempts to return the pendulum to equilibrium. Using
the Simulink element in a test lets you vary the model inputs and assess
the model outputs.

Note The following sections assume you have loaded the Inverted Pendulum
demo and deleted the Simulink element, as explained in “Before You Begin”
on page 4-2.
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Adding a Simulink Element
To add a Simulink element to a test, click the New > Test Element button
in the Test Browser and select the Simulink element. If you have a license
for Simulink, the element list contains the Simulink element, as shown in
the following figure.

The SystemTest software adds the Simulink element to the test and opens the
Simulink element Properties pane.
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Specifying the Simulink Model
When you first add the element, the icon in the Test Browser has a red x,
meaning that the element requires some information. The Simulink model
field in the Simulink element Properties pane is outlined in red, indicating
that it is a required field. You must specify the model that the Simulink
element will interact with. If the model is on the MATLAB path, you can type
its name in the Simulink model field. If you are not sure of the name, or
the model is not on the path, you can browse to its location using the browse
button.

For the Inverted Pendulum example, type systemtestpendulum in the
Simulink model field and press Enter. The SystemTest software opens
the systemtestpendulum model in Simulink and opens the Pendulum
Visualization window.

Overriding Simulink Model Inputs
Using test vectors and test variables, you can override the following Simulink
model inputs:

• Block parameters — Described in “Overriding Simulink Block Parameters”
on page 4-6

• Model and base workspace variables — Described in “Overriding to
Workspace Variables” on page 4-8

• Inport signals — Described in “Overriding Simulink Model Inport Signals”
on page 4-10

Overriding Simulink Block Parameters
You can override Simulink block parameters with SystemTest test vectors
or test variables. When you run the test, Simulink runs the model using
data provided by the SystemTest software. Overriding does not change your
Simulink model file; it only overrides in the test. The procedure for creating
block parameter overrides requires that you select your block in the Simulink
model, but everything else you need to do happens within the Simulink
element Properties pane.
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To override a Simulink block parameter:

1 In the Mappings tab of the Properties pane for the Simulink element
in the SystemTest software, expand the Override Block Parameters
with SystemTest Data section and click the New Mapping button,
and select Select Block to Add. This opens the model in Simulink, if it
is not already open.

2 In the Simulink model window, click the block containing the parameter
you want to override. For this example, click the Pendulum block in the
systemtestpendulum model window.

3 In the SystemTest software, return to the Simulink element Properties
pane and, in the Override Block Parameters section, you’ll see that
the Pendulum was added. If you click the New Mapping button again,
you’ll see that the SystemTest software also adds an entry to this menu
for the block.

In the override table, the Simulink Data field shows that this entry is
linked to the Pendulum block but the question mark (?) indicates that no
parameter for the block has been mapped.
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4 Select the parameter from the block that you want to map. Click the
Simulink Data field for the block and select a parameter from the list. For
the Inverted Pendulum demo example, select Pendulum:Mass of cart
(kg).

5 Specify the SystemTest test vector or test variable you want to map to
this block parameter. Click the SystemTest Data field for the block
parameter. This shows you all defined SystemTest test vectors and test
variables available for mapping. For this example, select cart.

Overriding to Workspace Variables
You can use a SystemTest test vector or test variable to override either a
MATLAB base workspace variable or a Simulink model workspace variable.
This lets you define test values and conditions in the SystemTest software
and have a Simulink model act on them.

This section describes how you can use the values in the pend and distance
test vectors to override the model workspace variables masspend and
penddistance in the Inverted Pendulum demo.
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To override workspace variables:

1 Expand the Override MATLAB and Model Workspace Variables with
SystemTest Data area of the Simulink element Properties pane, and
click the New Mapping button.

2 Select the workspace variable you want to override. Click the Simulink
Data field of this row to see all available base workspace variables and
Simulink model workspace variables. For the Inverted Pendulum example,
select masspend.

3 Specify which SystemTest test vector or test variable you want to map to
the Simulink workspace variable. Click the SystemTest Data field of this
row to see all available test vectors and test variables. For this example,
select pend.
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4 Repeat steps 1 to 3 to override the Simulink model workspace variable
penddistance with the SystemTest test vector distance.

Overriding Simulink Model Inport Signals
As with block parameters and workspace variables, you can use the
SystemTest software to override a model’s inport signals. This lets you
externally manipulate the input signal of a Simulink model.

The Inverted Pendulum demo example does not override any inport signals.

For information on how to override inport signals and an example, see
“Overriding Inport Block Signals” on page 4-22.

Optimizing Test Vectors to Work with Inport Signals

4-10



Mapping Test Vectors and Test Variables to a Simulink® Model

Simulink allows you to import input signal and initial state data from the
MATLAB workspace and export output signal and state data to the MATLAB
workspace during simulation. In the SystemTest software, you can specify
the contents of a test vector so that it is used as a Simulink inport. To do that,
use the vector as the mapping in your Simulink element, by selecting it in the
SystemTest Data row as described above.

The Simulink documentation contains guidance on importing data to Simulink
inport signals. You can create the same type of data in your SystemTest
test vectors that you then map to inport signals. For more information on
appropriate data types, see Importing and Exporting Simulation Data in
the Simulink documentation.
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Example for Overriding Inport Signals Using Data Arrays

One of the data formats described in Importing and Exporting Simulation Data
in the Simulink documentation is the use of data arrays for specifying input
data to an Inport block. This example uses the systemtestinputdemo.mdl
model to illustrate how the SystemTest software can be used to override the
three Inport blocks in the model with test signals.

The first step involves constructing a test vector that specifies the different
signal test cases. This can be done by creating a MATLAB function that
simply returns a test vector containing the different test cases you would
like to use for each test iteration. A sample MATLAB function, called
GETTESTVECTOR, that does this is provided below.

Once this function is saved as GETTESTVECTOR, you can create a
SystemTest test vector whose expression is set to GETTESTVECTOR. This
will create a 1-by-3 test vector cell array within the SystemTest software,
where each entry in the cell array represents the time and signal data for
the three Inport blocks.
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For detailed information on the Simulink data array format, or other formats
supported by Simulink Inport blocks, see Importing and Exporting Simulation
Data in the Simulink documentation.

Mapping Simulink Model Outputs to Test Variables
Using test variables you can assign the output from the following types of
Simulink model data:

• Logged signals — Described in “Mapping Simulink Logged Signals to Test
Variables” on page 4-14

• Outport signals — Described in “Mapping Simulink Outport Signals to
Test Variables” on page 4-16

• To Workspace blocks — Described in “Mapping Simulink To Workspace
Blocks to Test Variables” on page 4-18

After you map model outputs to test variables, you can incorporate the model
data into the SystemTest software. This section shows you how to map this
data for the Inverted Pendulum example.

Note The output from Simulink models can only be mapped to SystemTest
test variables. You cannot map this output to SystemTest test vectors.

Note If you are mapping logged signals, outport signals, or To Workspace
blocks to test variables, as shown in the following procedures, then you can
optionally use the Mappings Assistant if you want the variables to have the
same names as the inputs. This is useful if your model contains many signals
or blocks and you want to name the outputs the same way. You no longer
have to create test variables with matching names manually. See “Using the
Model Output Mappings Assistant” on page 4-20 for more information.
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Mapping Simulink Logged Signals to Test Variables
Logged signals are a way to obtain outputs from a model without adding more
outports. Using logged signals, you can identify a particular signal and map
the output to a SystemTest test variable.

To map logged signals to a SystemTest test variable:

1 Expand the Assign Model Outputs to SystemTest Data section of the
Simulink element Properties pane, and click the New Mapping button.
From the list, select Logged Signal. The SystemTest software adds a
row for a new mapping of this type.

2 Specify the signal you want to capture. Click the Simulink Data field
to see all the signals in the model. For the Inverted Pendulum example,
select pendout.

Note If you added logged signals to your model and they do not appear
in this list, click the refresh button, on the Properties pane next to the
model name, to update the list.
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3 Specify the SystemTest test variable to which you want to map the output.
Click the SystemTest Data field and select a test variable. For the
Inverted Pendulum example, select st_loggedsignal.

The SystemTest software creates the mapping to the test variable.
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Note If you are mapping logged signals to test variables, as shown in the
above procedure, then you can optionally use the Mappings Assistant if you
want the variables to have the same names as the inputs. This is useful if
your model contains many signals or blocks and you want to name the outputs
the same way. You no longer have to create test variables with matching
names manually. See “Using the Model Output Mappings Assistant” on page
4-20 for more information.

Mapping Simulink Outport Signals to Test Variables
The SystemTest software lets you map all outport signals to a test variable
for further processing in the SystemTest software.

To map Simulink outport signals to a test variable:

1 In the Assign Model Outputs to SystemTest Data section of the
Simulink element Properties pane, click the New Mapping button. From
the list, select Outport Signal. The SystemTest software adds a row for a
new mapping of this type.

2 Specify the outport signal you want to capture. Click the Simulink Data
field and select a signal. For this example, select Out1.
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3 Specify the SystemTest test variable to which you want to map the outport
signals. Click the SystemTest Data field and select a test variable from
the list. For this example, select st_outportsignal.

The SystemTest software creates the mapping to the test variable.

Note If you are mapping outport signals to test variables, as shown in the
above procedure, then you can optionally use the Mappings Assistant if you
want the variables to have the same names as the inputs. This is useful if
your model contains many signals or blocks and you want to name the outputs
the same way. You no longer have to create test variables with matching
names manually. See “Using the Model Output Mappings Assistant” on page
4-20 for more information.
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Mapping Simulink To Workspace Blocks to Test Variables
When Simulink runs a model with To Workspace blocks, these blocks save
model information in the MATLAB workspace as variables. Using the
SystemTest software, this data can be mapped to SystemTest test variables.

This section shows how you create To Workspace block mappings in the
SystemTest software using the Inverted Pendulum demo as an example.

To map the To Workspace block:

1 In the Assign Model Outputs to SystemTest Data section of the
Simulink element Properties pane, click the New Mapping button. From
the list, select To Workspace Block. The SystemTest software adds a
row for a new mapping of this type.

2 Specify the To Workspace block in the model that you want to capture.
Click the Simulink Data field and select the block from the list. For this
example, select To Workspace.

3 Specify the SystemTest test variable to which you want to map the To
Workspace block. Click the SystemTest Data field and select a test
variable from the list. For this example, select New Test Variable to
create a test variable.
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The SystemTest software opens the Edit Variable dialog box. Assign a
name to the test variable and optionally an initial value, and then click
OK. Name the test variable ToWSResult.
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The SystemTest software creates the mapping to the new test variable and
adds the new test variable to the list in the Test Variables pane.

Note If you are mapping To Workspace blocks to test variables, as shown in
the above procedure, then you can optionally use the Mappings Assistant if
you want the variables to have the same names as the inputs. This is useful if
your model contains many signals or blocks and you want to name the outputs
the same way. You no longer have to create test variables with matching
names manually. See “Using the Model Output Mappings Assistant” on page
4-20 for more information.

Using the Model Output Mappings Assistant
If you are mapping logged signals, outport signals, or To Workspace blocks to
test variables, for example in the procedures in the above section “Mapping
Simulink Model Outputs to Test Variables” on page 4-13, then you can
optionally use the Mappings Assistant if you want the variables to have the
same names as the inputs. This is useful if your model contains many signals
or blocks and you want to name the outputs the same way. You no longer have
to create test variables with matching names manually. Using the Mappings
Assistant is the preferred method of setting up mappings since it is easier.

1 In the Assign Model Outputs to SystemTest Data section of the
Simulink element, click theMappings Assistant button above the table.

2 In the Model Output Mappings Assistant dialog box, choose your
mapping(s) in the Create mappings for each section.
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• If your model contains any logged signals, the Logged Signals option is
available. Select the option to map the logged signal(s) to test variable(s).
If the model contains no logged signals, this option is disabled.

• If your model contains any outport signals, the Outport Signals
option is available. Select the option to map the outport signal(s) to
test variable(s). If the model contains no outport signals, this option
is disabled.

• If your model contains any To Workspace blocks, the To Workspace
Blocks option is available. Select the option to map the block(s) to test
variable(s). If the model contains no To Workspace blocks, this option
is disabled.

3 Click OK to create the mappings.

The Simulink Data column then displays the names of the logged
signals, outports, or To Workspace blocks that the model contained. The
SystemTest Data column displays the test variables created with the
same name.

For example, if the model contains two outports called Out1 and Out2, the
Simulink Data column displays Out1 and Out2, and the SystemTest
Data column displays Out1 and Out2 to represent the test variables that
were created.

Editing a Test Vector or Test Variable from within the
Element
If you want to edit a test vector or test variable while working in the Simulink
element, you can open the appropriate editor by right-clicking on the name of
the test vector or test variable in any of the tables on theMappings tab.
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Overriding Inport Block Signals

In this section...

“Introduction” on page 4-22
“Overriding Inport Block Signals in a Simulink Element” on page 4-22
“Using the Inport Block Mappings Assistant” on page 4-27
“Example: Overriding Simulink Inport Blocks Using a Spreadsheet Data
Test Vector” on page 4-28
“Mapping Logged Signals from a Model to Inport Blocks” on page 4-36
“Editing a Test Vector or Test Variable from within the Element” on page
4-37

Introduction
The examples in “Mapping Test Vectors and Test Variables to a Simulink
Model” on page 4-4 described how to override block parameters and workspace
variables. Similarly, you can override signals to root-level Inport blocks in
Simulink with SystemTest data.

Because the Simulink element uses the Inport block names, not the port
numbers, your test works even if you reorder the Inport blocks in the model.

Some users store signal values in a Microsoft Excel spreadsheet or .csv
file. You can create a test vector that reads values from a spreadsheet and
use that as your Inport block signal mapping. The “Example: Overriding
Simulink Inport Blocks Using a Spreadsheet Data Test Vector” on page 4-28
section shows such a scenario.

You can also store signal values in a MAT-file and then create a test vector
that reads the values from the MAT-file. The “Mapping Logged Signals from a
Model to Inport Blocks” on page 4-36 section shows this scenario.

Overriding Inport Block Signals in a Simulink Element
To override Inport block signals:

4-22



Overriding Inport Block Signals

1 If you have a model that contains Inport blocks and you have created a
Simulink element that uses that model, click the Mappings tab inside
the Simulink element.

2 Expand the Override Inport Block Signals with SystemTest Data
section by clicking the expander arrow on the right side of the section title.

3 Designate your mappings.

The user interface indicates how many Inport blocks your model contains.
For example, the model used in the Simulink Input demo contains three
Inport blocks, as shown here. You can open this demo by typing the
following in the MATLAB command line:

systemtest SimulinkInputDemo1
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The first option, Do not override Inport block signals, is selected by
default. That means the test will run the model without modifying any
Inport block settings. Any data the Inport blocks are configured to use will
be used during execution. If you want to override the model, use one of
the other two options.

The All Inport blocks are mapped using option allows you to map data
to all Inport blocks at once. Use the drop-down list to choose an existing
test vector or test variable, or to create a new one. This supports any data
format the Simulink model supports. For example, it could be a test vector
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that is an array of time and three signal values, such as [time, U1, U2,
U3].

If you want to map individual Inport blocks, select the Individual Inport
blocks are mapped using option.

When you select this option, the mapping table becomes editable. In the
case shown here, In1 and In2 are being overridden with SystemTest data,
and In3 is using the value in the model.
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The table displays all Inport blocks contained in the model. By default,
the SystemTest Data column is assigned as Inherit from model. This
is especially convenient if you have a large number of Inport block signals
and only want to override a small number of them in your test. You would
just change the SystemTest Data column value for the ones you want
to override.

You can update the list of Inport blocks that are displayed in the table
by clicking the Open and update model state button in the Simulink
element. The Inports listed in the table are sortable.

Note If you open a TEST-File and do not see the Inport blocks from your
model reflected in the Simulink element, click the Open and update
model state button:

to populate the Inport table.

Note If you have variables in a Spreadsheet Data test vector or a
MAT-File test vector, you can optionally use the Mappings Assistant. Click
the Mappings Assistant button above the table. For more information
on using the Mappings Assistant, see “Using the Inport Block Mappings
Assistant” on page 4-27.

4 If you are using individual mappings, you need to define the test signal
time and the end time. If you are using either of the other mapping options
(inherit from model or map all), skip this step since the time options only
apply to individual mappings.

In the Define test signal time option, you can specify the simulation time
signal to provide to the model. To specify the time signal using a test vector
or test variable, select Map test signal time to. To specify a time signal
based on a desired simulation time step, select Manually specify a time
step and then enter a valid time step, which must be a positive number.
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In the To calculate end time of simulation option, either use the model’s
stop time, or use the signal’s end time based on the time step you specified.
The Use model stop time option stops the simulation of the model at
the end time configured in the model. The Use signal’s end time option
stops the simulation of the model at the end of the test signal, temporarily
overriding the end time of the model with the test signal end time.

Note The Define test signal time option and the To calculate end
time of simulation option are disabled if all individual Inport mappings
are set to inherit from the model.

Using the Inport Block Mappings Assistant
If you are overriding Inport block signals, as shown in “Overriding Inport
Block Signals in a Simulink Element” on page 4-22, then you can optionally
use the Mappings Assistant when you use the Individual Inport blocks
are mapped using option.

1 When overriding Inport block signals, select the Individual Inport
blocks are mapped using option.

2 Click theMappings Assistant button above the table. This button is only
available when you are configuring individual mappings.

3 In the Inport Block Mappings Assistant dialog box, choose your mapping in
the Override each Inport block using section.

• If you are using a Spreadsheet Data test vector, select the A
spreadsheet test vectors headers option. Then in the drop-down list,
select an existing Spreadsheet Data test vector, or create a new one.

• If you are using a MAT-File test vector, select the A MAT-File test
vectors selected variables option. Then in the drop-down list, select
an existing MAT-File test vector, or create a new one.

• If you have a test variable whose name matches the Inport block, select
the An existing test variable with a matching name option.

4 The If an Inport block name cannot be matched section determines
what happens in the case of one or more variables in the selected test
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vector not matching an Inport block name. Select the option you want the
Simulink element to perform. Inherit from Model is the default.

5 The Summary section displays information on how many root-level Inport
blocks are found in the model, how many are mapped to the test vector you
selected if you are mapping from a test vector, and how may will use the
option you chose in step 4 in the case of non-matches.

When you are finished configuring the mappings and viewing the summary,
click OK to create the mappings.

The mappings are then displayed in the table.

Example: Overriding Simulink Inport Blocks Using a
Spreadsheet Data Test Vector
In this example, a Simulink element is being used to test a model of a fuel
rate controller. To see the test and the model, open the demo by typing the
following at the MATLAB command line:

systemtest('demosystest_fuelctrlsldv.test');

The model has four Inport blocks that represent throttle angle, engine speed,
exhaust gas, and manifold pressure.
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The tester has values for these four blocks in a Microsoft Excel spreadsheet.
It contains 37 sets of generated values for the blocks. Each set of values is on
a different sheet within the spreadsheet, representing a testing scenario for
the model. One of the sheets is shown here.
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Column A represents the simulation time signal. Columns B through E
represent test data for the four Inports in the model. Each of the 37 sheets is
set up the same way but contains different values.

To set up the test vector that reads the data from the spreadsheet:

1 Create the test vector by clicking theNew button in the Test Vectors pane.

2 In the Insert Test Vector dialog box, select Spreadsheet Data as the
vector type.

3 On the General tab, name the test vector InputSignal.

4 Click the Add File button and browse to the Microsoft Excel spreadsheet.
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5 Click the Select All button to select all sheets in the spreadsheet file.

6 On the Data Selection tab, keep the default of column in the Data is
arranged by option.

7 In the Read data from column option, enter A to E, starting at row 1.
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8 Select the First row is a header option, since you can see in the above
figure of the spreadsheet that row 1 of the file contains text labels.

9 Select the Treat each selected sheet as a test vector value option.

The configured test vector appears as follows.

10 Click OK in the Insert Test Vector dialog box.
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The new vector appears in the table in the Test Vectors pane. You can see
that the length is 37 because there are 37 sheets in the spreadsheet file and
each sheet is being treated as one value in the vector.
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Now that the test vector is set up, you can set up the Simulink element to
override the Inport blocks using the test vector values from the underlying
spreadsheet file.

1 Create a Simulink element by clicking New > Test Element > Simulink
button in the Test Browser.

2 Click the browse button to locate the Fuel Rate Controller model.

3 On theMappings tab, expand the Override Inport Block Signals with
SystemTest Data section if it is not open.

4 Select the Individual Inport blocks are mapped using option. The four
Inport blocks appear in the table.

5 For each Inport block, use the drop-down list in the SystemTest Data
column to override the Inport block with the appropriate data in the test
vector that was created earlier.

For example, for throttle, click the drop-down list, expand the InputSignal
test vector entry, and select throttle. Do the same for the other three
signals.

The entries under the InputSignal test vector represent the underlying
columns in the spreadsheet. Since the Spreadsheet Data test vector called
InputSignal was created using the columns and the headers, the columns
appear named with their headers in the list for easy identification, for
example, InputSignal(throttle).

6 In the Define test signal time option, select Map test signal time to
and choose InputSignal(Time).

Time is the first column in the spreadsheet and contains the simulation
time signal for the model. The test will use these time step values when
the Simulink element is executed.

7 Select the Use signal’s end time option, so that the end times provided in
the spreadsheet are used.

The configured Simulink element appears as follows.
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When the test is executed, the Simulink element will test the model using the
Inport block signals mapped from the spreadsheet.
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Mapping Logged Signals from a Model to Inport
Blocks
You can map logged signals from a Simulink model, including bus signals,
to Inport blocks of a model using the Simulink element and a test vector or
test variable that contains the logged signal data.

A common usage scenario is to log the signals while running a model and
store them in a MAT-file. Then you can acquire them from the Mat-file using
a MAT-File test vector and map that data to Inport blocks in the Simulink
element. The following high-level steps outline this usage scenario.

1 Do one of the following:

Run your model that contains signals. The signals are logged as variables
in the MATLAB workspace. Save the variables as a MAT-file.

OR

Alternatively, use MAT-file(s) that have already been created and saved.

2 In the SystemTest software, create a MAT-File test vector using the
MAT-file that your signals are saved in. See “Creating MAT-File Test
Vectors” on page 2-13 for more information on MAT-File test vectors.

3 Add a Simulink element to your test, and select the model that you want
to test.

4 In the Override Inport Block Signals with SystemTest Data section,
select the All Inport blocks are mapped option.

5 From the drop-down list, select the MAT-File test vector you created, and
drill down into the variable that represents the signal you want to use.
This is how you map the logged signals to the Inport blocks.

Note that the logged signal(s) and the Inport block(s) must have exactly the
same name(s) for the Simulink element to simulate the model successfully.
See the usage notes below.

6 Run the test.
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Important Usage Notes

– The logged signal(s) and Inport block(s) must have identical names that
match exactly. To use this feature, each Inport block name must match a
corresponding signal name within the logged data. If it does not, you can
rename the Inport block or the signal in the logged data to avoid an error.
You can have other signals in the logged data, but each Inport block must
exactly match a signal name.

– The following data types are supported:

• Simulink.Timeseries.

• Simulink.TsArrays.

• Simulink.SubsysDataLogs.

Editing a Test Vector or Test Variable from within the
Element
If you want to edit a test vector or test variable while working in the Simulink
element, you can open the appropriate editor by right-clicking on the name of
the test vector or test variable in any of the tables on theMappings tab.
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Using Simulink Model Coverage
The model coverage feature provided by the Simulink Verification and
Validation software allows you to generate coverage analysis metrics for a
Simulink model, which can be incorporated directly into your SystemTest
test. Model coverage metrics allow you to validate your model by identifying
unexecuted subsystems, unselected switch positions, or untaken conditional
transition paths. You can generate a cumulative coverage report, specify
individual coverage options, or inherit a model’s coverage settings.

Note To use the model coverage feature, you need a license for Simulink
Verification and Validation.

The following basic steps describe the typical work flow to use this feature:

1 Use an existing Simulink element or add one by clicking the New > Test
Element button and selecting Simulink.

2 On the Properties pane, browse for your Simulink model using the browse
button next to the Simulink model field.

To see an example, you can run the Signal Builder demo by typing
systemtest demosystest_sigblder in MATLAB.

3 Configure the Simulink element as described in this chapter, using the
Mappings tab of the Properties pane to define model overrides and map
Simulink data to test variables.

4 On the Model Coverage tab, which appears if you have a license for the
Simulink Verification and Validation software, select the Enable model
coverage check box. The following figure shows the Signal Builder demo.
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5 If you want to use the model coverage settings you already have on the
Simulink model, select the Inherit coverage metric settings from the
model option. Then go to step 11.
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6 If you want to override the existing settings, select the Override model
coverage metric settings option.

7 Select Coverage for this model: <modelname>.

8 Click the Select Subsystem button in the Overridden Coverage
Metrics section to specify the root of your coverage data.
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9 If you have one or more referenced models and you want coverage for them,
select the Coverage for referenced models option.

Then click the Select Models button to select the referenced model(s) for
coverage. Make your selection in the Select Models for Coverage Analysis
dialog box and click OK.

Note that you can record coverage only for referenced models that operate
in Normal mode. You cannot enable coverage for referenced models
operating in Accelerated mode.

10 In the Coverage Metrics area, select the types of coverage your test
requires. The selected coverage types will be generated and shown in the
coverage report.
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11 Use the Map Coverage Data to SystemTest Variables field to map
coverage metrics to test variables. Click New Mapping and select Full
Coverage Instrumentation Path if you want coverage data below the
root you specified under Coverage for this model, or select Select Path
to Map if you want to pick an alternate coverage path, which must be
within the coverage instrumentation path. If you select the latter, your
Simulink model will open and you can select a block to specify an alternate
root for your coverage path.

12 Select the Metric you want to map to a test variable, and specify the test
variable to use under the SystemTest Data column.

13 Run your test.

14 View the coverage report by clicking the link in the Run Status pane.
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For more information on the model coverage feature, see “Using Model
Coverage” in the Simulink Verification and Validation documentation.
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Using Simulink Design Verifier Data Files in a Test
The Simulink Design Verifier Data File test vector can read test cases created
by Simulink Design Verifier. In order to use this test vector, you must have a
Simulink Design Verifier data file with test cases.

To use this feature, you first create a Simulink Design Verifier test harness
and set the generate SystemTest harness option in the Configuration
Parameters in Simulink. Then you can do one of two things:

• Generate a SystemTest harness for the model from Simulink. When it
completes, a new test opens automatically in SystemTest and a Simulink
Design Verifier Data File test vector is automatically created for you. A
Simulink element is also automatically created, with links to the model,
override mappings set, and model coverage enabled if your model uses
that feature. This workflow is described in “Automatically Creating a
SystemTest Test Harness from Simulink® Design Verifier” on page 2-49.

• If you already have a data file from Simulink Design Verifier, you can
create a test vector in SystemTest that uses the data, and create a Simulink
element and configure overrides in it. This workflow is described in
“Creating a Simulink Design Verifier Data File Test Vector” on page 2-51.
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Using Signal Builder Block Test Cases in a Test
If you use a Signal Builder block in a Simulink model, you can use the test
cases in a SystemTest test.

The most common workflow for this feature is to create a Simulink element
using the model containing the Signal Builder block, and create a Signal
Builder Block test vector from within the element. For an example of this
procedure, see “Creating Signal Builder Block Test Vectors” on page 2-63.
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5 Using the Instrument Control Toolbox™ Elements

Introduction

In this section...

“Instrument Control Toolbox Elements” on page 5-2
“Accessing Resources” on page 5-2

Instrument Control Toolbox Elements
This chapter describes how to use the Instrument Control Toolbox elements
with the SystemTest software.

The Instrument Control Toolbox elements provide a way to bring data from
instruments into a SystemTest test, or to transmit data from your instrument.
You can use these elements along with the other elements in the SystemTest
software to create tests for Simulink models and other applications.

Note To use the Instrument Control Toolbox elements, you need a license
for the Instrument Control Toolbox software. These three elements will not
appear in the SystemTest software without this license.

The Instrument Control Toolbox software provides three of elements that you
can use in the SystemTest software:

• To Instrument — For sending commands or data to your instrument

• From Instrument — For reading data from your instrument

• Query Instrument — For querying your instrument status or properties

You can configure these elements to communicate with your instruments by
using SystemTest resources supported by the Instrument Control Toolbox
software.

Accessing Resources
If your MATLAB installation includes elements that require resources, the
SystemTest desktop includes a Resources pane that lets you access the
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resources available through these toolboxes. For example, if your MATLAB
installation includes the Instrument Control Toolbox software, you can
see the Resources pane, if you open it from the Desktop menu. Select
Desktop > Resources to open the pane. It will tab with the Test Vectors
and Test Variables on the lower-left corner of the desktop. Resources are
toolbox-specific. For example, an Instrument resource might be configured to
connect to a device over your computer’s serial port.
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Example: Measuring a Generator’s Frequency

In this section...

“Introduction” on page 5-4
“Setting Up the Signal Generator” on page 5-5
“Setting Up the Oscilloscope” on page 5-9
“Taking the Measurement” on page 5-11
“Saving Test Results” on page 5-12
“Running the Test and Viewing Test Results” on page 5-13

Introduction
To illustrate how to use some of the Instrument Control Toolbox elements in
the SystemTest software, this section provides a step-by-step example.

In this example a SystemTest element configures a signal generator to
produce signals of various frequencies, which are measured by an oscilloscope
configured by other SystemTest elements.

The signal generator is a Hewlett-Packard 33120A at GPIB address 5, and
the oscilloscope is a Tektronix TDS 210 at GPIB address 4. For this example,
the generator output is fed directly to the scope input. The generator will
be programmed to generate signals of 1500, 5000, and 7500 Hz, while the
oscilloscope will measure each signal’s frequency.

The following sections explain the steps in this example.
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Setting Up the Signal Generator
The first element in the test programs the generator to output signals of
various frequencies. To test at three frequencies, the test be comprised of
three test cases, i.e., three iterations. This is a one-way communication to the
generator, so you use a To Instrument element.

1 Open the SystemTest software from MATLAB by selecting Start >
MATLAB > SystemTest > SystemTest Desktop. You can also just type
systemtest at the MATLAB command line.

2 When the SystemTest software opens, ensure that the Visualize and
plot saved results by launching the Test Results Viewer check box is
selected in the Properties pane.

3 No setup is required in the Pre Test, so the elements of this test are all in
the main test, so click Main Test in the Test Browser.

4 Add an element by clicking New Test Element > Instrument Control >
To Instrument.
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The element appears in the browser as To Instrument.

5 Double-click To Instrument, rename it Set Generator, and press Enter.

6 From the Properties pane’s Select an instrument resource list,
select New Instrument Resource. The instrument resource is the
communication channel between MATLAB and your instrument, in this
case the generator at GPIB address 5.

7 In the Edit: Instrument1 dialog box, enter Generator in the Name field.

8 Click Create to create an instrument resource.

9 In the New Object Creation dialog box, select GPIB in the Instrument
object type list. Select the appropriate Vendor (in this example, ni
for National Instruments), Board index (0), and instrument Primary
address (in this example, 5).

10 Click OK to return to the Edit: Instrument1 dialog box, where the
instrument object is now filled in and selected for this resource (GPIB0-5).
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11 Click OK to apply this resource and return to the Properties pane in the
SystemTest desktop.

12 In the Command text field, enter frequency followed by a space to
separate the text from the variable that will follow. This is the command to
set the frequency of the 33120A generator, as described in the instrument’s
reference manual proved by the vendor.

13 Click Data source and select New Test Vector. The name of the vector
you create for setting the generated frequencies is called genfreq. In the
Insert Test Vector dialog box, enter that text in the Name field, and set the
Expression field to [1500 5000 7500], including the brackets.
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14 Click OK to return to the SystemTest desktop.

Notice that the Main Test node in the tree now says (3 Iterations).
Because you entered three values in the test vector, the test is comprised of
three iterations, one for each frequency value in the test vector.

15 Keep the Send variable data as setting as String. The generator is
expecting string values for its commands.

16 Set a pause value of 2 seconds. This allows the generator to settle before
you measure its output.

The element should now resemble the following figure:
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Setting Up the Oscilloscope
You use a To Instrument element, which provides a one-way communication
to the oscilloscope, to program the scope to measure frequency.

1 Add an element by clicking New Test Element > Instrument Control >
To Instrument.
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2 Double-click To Instrument in the tree, rename it Set Scope, and press
Enter.

3 As before, create a new instrument resource, but this time call it Scope.
Create a new instrument object for it using Board index 0, and GPIB
primary address 4.

4 For the command text, enter measurement:immed:type frequency. This
puts the scope in the frequency measurement mode, as described in the
instrument’s reference manual provided by the vendor.

There is no test variable or pause required for this element, so the element
looks like the following figure:

To see the resources you created for communications with your two
instruments, click the Resources tab at the bottom of the SystemTest
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window. You can see the Generator and Scope resources, along with
their GPIB settings.

Taking the Measurement
With the generator and scope set up, you can take the measurement with the
scope using a Query Instrument element, which sends the command to the
scope for taking the measurement.

1 Add an element by clicking New Test Element > Instrument
Control > Query Instrument.

2 Double-click Query Instrument in the tree, rename it Measure with
Scope, and press Enter.

3 Use the existing instrument resource called Scope, by selecting it in the
Instrument resource list.

4 Enter the command to query for a measurement by typing
measurement:immed:value? in the Instrument query command field.

5 Select Store complete response, and select the Empty input buffer
after read check box.

6 From the Interpret data as list, select String (this scope returns ASCII
strings), and select the Convert string value to a numeric result check
box.

5-11



5 Using the Instrument Control Toolbox™ Elements

7 From the Assign data to list, select New Test Variable. For the
oscilloscope’s frequency measurement, name the test variable scopefreq.
It needs no initial value.

The element now looks like the following figure:

Saving Test Results
To view the results of your test, you must first specify the test variables you
want to save as test results. This is done in the Save Results Properties
pane.

1 Click Save Results in the test browser tree.
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2 In the Properties pane, click New Mapping.

3 From the Test Variable list, select scopefreq. This test variable contains
the frequency measurements provided by the oscilloscope during each Main
Test iteration, as shown in the following figure:

Running the Test and Viewing Test Results
Now that the test elements are all created, you can run the test.

1 Run your test. When the test is complete, the Test Results Viewer displays
your test results.

2 You can explore and plot your test results using the Viewer. Alternatively,
in the Data pane, right-click the name scopefreq and select Export. This
makes the variable available in your MATLAB workspace.
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3 To see the measurement results, at the MATLAB prompt type

format short g
scopefreq
scopefreq =

1501.5
5000
7500

This verifies that the signal generator is producing the expected signal
frequencies.
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Introduction

In this section...

“Overview” on page 6-2
“Data Acquisition Toolbox Test Elements” on page 6-2

Overview
This chapter describes how to use the Data Acquisition Toolbox elements
with the SystemTest software.

The Data Acquisition Toolbox elements provide a way to bring analog and
digital data from a data acquisition device into a SystemTest test, or to
send analog or digital data from your device. You can use these elements
along with the other elements in the SystemTest software to create tests for
Simulink models and other applications.

Note To use the Data Acquisition Toolbox elements, you need a license for
the Data Acquisition Toolbox software. These four elements will not appear
in the SystemTest software without this license.

Data Acquisition Toolbox Test Elements
The Data Acquisition Toolbox software provides four elements that you can
use in the SystemTest software:

• Analog Input — For reading analog data from your data acquisition device

• Analog Output — For sending analog data to your data acquisition device

• Digital Input — For reading digital data from your data acquisition device

• Digital Output — For sending digital data to your data acquisition device

You can configure each test element to communicate with your data
acquisition devices for sending or receiving digital or analog data.
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Example: Testing a Voltage Regulator

In this section...

“Introduction” on page 6-3
“Sending Analog Stimulus Data to the DUT” on page 6-4
“Enabling the DUT with Digital Data” on page 6-7
“Receiving Analog Response Data from the DUT” on page 6-9
“Disabling the DUT with Digital Data” on page 6-10
“Performing Data Analysis” on page 6-12
“Defining Post Test Elements” on page 6-13
“Saving and Viewing Test Results” on page 6-14

Introduction
To illustrate how to use some of the Data Acquisition Toolbox test elements in
the SystemTest software, this section provides a step-by-step example. The
example shows how to use the elements that send data to a device under test
(DUT) and receive data from a device under test, using both analog channels
and digital lines.

This example samples the response of a 5-V voltage regulator that is
stimulated with three different voltages of 4, 5, and 7.5 volts. The regulator
has an enable function controlled by a digital signal. In this example, you
collect 22,000 samples per second of the DUT response for 2 seconds.

All data going to and from the DUT is handled by a National Instruments®
PCI-6035E data acquisition card. The example uses this card’s analog output
for the DUT stimulus, analog input for capturing the DUT response, and
digital output for controlling the DUT’s enable line. The test configuration is
shown in the following figure:
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The following sections contain the steps in this example.

Sending Analog Stimulus Data to the DUT
Stimulus data is sent to the DUT from an analog output channel of your
data acquisition card.

1 Open the SystemTest software in MATLAB by selecting
Start > MATLAB > SystemTest > SystemTest Desktop. You can also
type systemtest at the MATLAB command line.

2 This example does not use the Pre Test section, so select the Main Test
section in the Test Browser pane.

3 Add an Analog Output element by selecting New Test Element > Data
Acquisition > Analog Output.
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The new element appears in the browser tree, and its properties appear
in the Properties pane. The SystemTest software scans your computer
for installed data acquisition adaptors and devices. This can take several
seconds.

4 Double-click the new Analog Output node in the browser tree, and enter a
new name for this element, such as Stimulate DUT.

5 Since we have three test cases, we need to create a test vector containing
the three voltage settings to test against. Click the Test Vectors tab. The
voltage values for the stimulus to the DUT are held in a test vector. Click
New Vector to create a new test vector.

6 In the Insert Test Vector dialog box, click the name TestVector1 and enter
a new name for your vector, such as DUTstimulus.

7 Click the default 1 : 1 : 10 entry in the Expression field, and replace
it with the values for your test: [4, 5, 7.5] (be sure to include the
brackets) and click OK. Notice that because there are three values in your
vector, the browser tree now indicates that the Main Test will run three
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iterations. Each iteration will use one of the three values in the vector for
the DUT stimulus voltage.

8 In the Properties pane, select the adaptor and device to use for the test.
This example uses the nidaq adaptor, and the device is a PCI-6035E.

9 The example hardware configuration uses the card’s analog output
hardware channel 0 to provide the DUT’s stimulus. So select the check box
for this channel. The element will generate signals of 4, 5, and 7.5 volts, so
keep the default output range of [-10.0 10.0].

10 From the Data source list, select the DUTstimulus test vector.

11 Enter a value of 1 for Output rate. You are using a single static value
rather than a sampled waveform, so this is not critical.

12 Enter a value of 1 for Number of times to output data. The card will
hold its last programmed value, so you need to send it only once.
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The Properties pane now looks like the following figure:

Enabling the DUT with Digital Data
To send a digital enable signal to the DUT, use a digital output element.

1 Select New Test Element > Data Acquisition > Digital Output.

2 Double-click the new Digital Output element in the browser tree, and type
a new name for this element, such as Enable DUT.

3 Click the Test Variables tab.

4 Click the New button to create a new variable. You will create two
variables: one for enabling and one for disabling the DUT.

5 Click the name Var1, and replace it with the text DUTenable.
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6 Click its empty Initial Value entry, and enter 1.

7 Repeat steps 4 to 6 to create a second test variable, but name it DUTdisable
with an initial value of 0.

8 In the Properties pane for the Enable DUT element, select the adaptor
and device for sending this data. Again, you are using the nidaq adaptor,
and the device is a PCI-6035E.

9 The hardware configuration uses the card’s digital output port 0, line 3 for
the enable signal, so select the check box for this line.

10 From the Data source list, select the variable DUTenable.

The Properties pane now looks like the following figure:
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Receiving Analog Response Data from the DUT
The next element in the test samples the output from the DUT and assigns
the acquired data to a test variable.

1 Select New Test Element > Data Acquisition > Analog Input.

2 Double-click the new Analog Input element in the browser tree, and enter
a new name for this element, such as DUT Response.

3 In the Properties pane, select the adaptor and device to use for the test.
This example uses the nidaq adaptor, and the device is a PCI-6035E.

4 The hardware configuration uses the card’s analog input hardware
channel 3 to read the DUT’s response, so select the check box for this
channel. The expected signal will be about 5 volts, so keep the default
output range of [-10.0 10.0].

5 Set a sample rate of 22000. Because of hardware limitations, the actual
sample rate may not exactly match the value you specify.

6 In the Acquire field, specify to acquire data for 2 seconds. Set seconds in
the unit list to the right of the value field.

7 In the Assign data to field, select New Test Variable from the list. This
is where you specify what test variable to assign the acquired data to. The
Edit dialog box appears.
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8 Enter a name for the test variable, such as DUTresponse, then click OK
to create the test variable.

The Properties pane now looks like the following figure:

Disabling the DUT with Digital Data
The next step is to disable the DUT with a digital output element that turns
off the DUT’s enable line. This element is similar to the Enable DUT element,
except it sends a different value to the DUT.
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1 Select New Test Element > Data Acquisition > Digital Output.

2 Double-click the new Digital Output element in the browser tree, and
enter a new name for this element, such as Disable DUT.

You already created the test variable DUTdisable, which you will use in
this element.

3 In the Properties pane for the Disable DUT element, select the adaptor
and device for sending this data. Again, you are using the nidaq adaptor,
and the device is a PCI-6035E.

4 The hardware configuration uses the card’s digital output port 0, line 3 for
the enable signal, so select the check box for this line.

5 From the Data source list, select the variable DUTdisable.
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The Properties pane now looks like the following figure:

Performing Data Analysis
At this stage, you might perform any analysis or visualization routines on the
data generated by the DUT. You can do this in a MATLAB element.

1 Select New Test Element > MATLAB.

2 Double-click the new MATLAB element in the browser tree, and enter a
new name for this element, such as Process Data.

3 In the MATLAB Script edit field of the Properties pane, enter any
MATLAB code that you need for analyzing your test variables. You
might be interested in measuring ripple, noise, regulation, or many other
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characteristics. You can access the DUT response by referring to the test
variable DUTresponse. The stimulus data is available in the test variable
DUTstimulus.

The following figure shows a MATLAB element with only some comments
added in the Properties pane.

Defining Post Test Elements
In this example, it is recommended to include an element in the Post Test
section to disable the DUT.

1 Click the Post Test section in the browser tree.

2 Create a digital output element set up like the element you made in
“Disabling the DUT with Digital Data” on page 6-10.
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With the extra Disable DUT element, the test now looks like the following
figure:

The Post Test section of the test could also perform any analysis that requires
completion of all the iterations of the Main Test.

Saving and Viewing Test Results
Before running a test, you must specify which test variables you want to save
as a test result. In the Save Results Properties pane, you select the test
variable that you want to save and map it to a test result name.

Saved test results will be viewable with the Test Results Viewer. To launch
the Test Results Viewer, click on the test name in the Test Browser. In the
Properties pane, make sure the Visualize and plot saved results by
launching the Test Results Viewer option is checked.
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Using the Image Acquisition
Toolbox Element

The Image Acquisition Toolbox software includes a SystemTest element that
you can use to bring live video data into a SystemTest test.

• “Introduction” on page 7-2

• “Example: Acquiring Video Data in a Test” on page 7-3
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Introduction
This chapter describes how to use the Image Acquisition Toolbox element
with the SystemTest software.

The Image Acquisition Toolbox element, called Video Input, provides a way
to acquire live video data in a SystemTest test. You can use this element
along with the other elements in the SystemTest software to create tests for
Simulink models and other applications.

To learn how to use the Image Acquisition Toolbox element in the SystemTest
software, see “Example: Acquiring Video Data in a Test” on page 7-3.

Note To use the Image Acquisition Toolbox element, you need a license for
the Image Acquisition Toolbox software. The Video Input element will not
appear in the SystemTest software if you do not.
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Example: Acquiring Video Data in a Test

In this section...

“Adding the Video Input Element to a Test” on page 7-3
“Saving and Viewing Test Results” on page 7-8
“Running the Test” on page 7-9

Adding the Video Input Element to a Test
This example illustrates how to use the Video Input element in the
SystemTest software. The example uses the Video Input element to acquire
a single frame of video for each iteration of the test and uses the MATLAB
element to display the acquired image.

The first step is to add the element, as shown in this section. The two
following sections contain the remaining steps.

To create a test using the Video Input element:

1 Open the SystemTest software by selecting Start > MATLAB >
SystemTest > SystemTest Desktop in MATLAB. You can also just type
systemtest at the MATLAB command line.

2 In the SystemTest desktop, start to create your test by selectingMain Test
and adding the Video Input element. In the Test Browser, click New
Test Element > Image Acquisition > Video Input.
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The SystemTest software adds the Video Input element to the Main Test
section of the test and displays the Properties pane for the Video Input
element. (You can also add elements to the Pre Test or Post Test sections of
a test but this example does not require it.)

In the following figure, note the red x in the Video Input element icon in
the Test Browser. This red x indicates that the element is in an error
state. The SystemTest software outlines the required fields in red in the
Properties pane.
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3 Specify the device you want to use to acquire image data in the Properties
pane for the Video Input element. You must specify the name of the
adaptor you want to use in the Adaptor field, which is a required field.
(The SystemTest software uses red outlining to indicate required fields
that are not filled in yet.) The SystemTest software can detect any image
acquisition devices supported by the Image Acquisition Toolbox software
that are connected to your system and fills in this field with a default
value based on the alphabetical list of devices, if one is available. For our
example, in the figure, the SystemTest software sets the Adaptor field to
winvideo. If your system has other adaptors that can connect to devices,
select the adaptor that you want to use from the Adaptor list.

After the Adaptor field is set, the SystemTest software fills in the Device,
Video Format, and Selected Source fields with default values. The
SystemTest software populates the drop-down lists associated with each
field with all available options for the field. Adaptors can support multiple
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devices and devices can support multiple formats. The SystemTest
software preselects the default values for these fields but lists all available
options in the drop-down lists associated with these fields. The following
figure shows the list for the Video Format field:

4 Specify the number of frames you want to acquire at each iteration of the
test in the Number of frames field, which is a required field. For this
example, we only need to acquire one frame for each iteration, so set this
field to 1.

5 Specify the name of the SystemTest test variable that the acquired video
data will be assigned to at each iteration. This is a required field. You can
select a test variable from the list or create a new test variable by selecting
New Test Variable.
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If you select New Test Variable, the SystemTest software opens the Edit
dialog box. Assign a name to the test variable, or accept the default name,
and click OK. You do not need to assign the test variable an initial value.

The SystemTest software adds the new test variable to the list in the Test
Variables pane.

6 Optionally, verify the Video Input element settings by clicking the Preview
Window button. The SystemTest software opens a Video Preview window
and displays a live video stream from your camera. You can use this to
verify that your hardware is configured correctly. You should close the
preview window before running the test.

7 To complete this example test, add a MATLAB element to the Main Test
section. In this MATLAB element, call the MATLAB image function to
display the image frame acquired at each iteration.
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This completes this example test illustrating how to incorporate image data
into the SystemTest software. In a real testing application, you can define
test vectors that determine the number of iterations of your test that the
SystemTest software performs. You can also compare test variables against
defined limits in the Limit Check element and specify pass/fail criteria.

Saving and Viewing Test Results
Before running a test, you must specify which test variables you want to save
as a test result. In the Save Results Properties pane, you select the test
variable that you want to save and map it to a test result name.
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Saved test results will be viewable with the Test Results Viewer. To launch
the Test Results Viewer, click the test name in the Test Browser. In the
Properties pane, make sure the Visualize and plot saved results by
launching the Test Results Viewer option is selected.

Running the Test
To run the test, do one of the following:

• Click the Run button.

• Select Run > Run.

• Press the F5 key.

While the test executes, the SystemTest software reports on the progress
of the test in the Run Status pane.

After the test runs, the Test Results Viewer will launch. In the Viewer, select
the type of plot you want to create. For this example, select Image Plot
from the Plots menu or click the Image Plot button in the Test Results
Viewer toolbar.
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SystemTest Software and Parallel Computing Toolbox
Integration

You can distribute SystemTest tests across multiple computers or processors.
You can set up a test and then distribute Main Test iterations as tasks, which
are performed concurrently by different workers. This can help speed up the
total time the test takes to execute.

Note To distribute tests in the SystemTest software, you need a license for
the Parallel Computing Toolbox™ software.

You set up a distributed test as you would set up any test, using the
SystemTest desktop. Then you use the Distributed tab on the Test
Properties pane to set up the test distribution.

To access the distributed testing functionality in the SystemTest software, do
one of the following:

• Select your test name in the Test Browser. This is the top node in the
Test Browser, that lists the name you give the test when you save it, or
“Untitled,” if you have not saved it yet. Then click on the Distributed
tab in the Test Properties pane.

• Select Tools > Distributed Testing on the SystemTest menu. This opens
the Distributed tab.

Note that if you do not have the Parallel Computing Toolbox software
installed, the tab displays a message indicating you cannot use the distributed
testing functionality.

Note To see a diagram that shows how distributed testing with the
SystemTest software works and illustrates the relationship between the
SystemTest software, the scheduler, and the workers, see “Running a
Distributed Test” on page 8-14.
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Enabling Distributed Testing
You must select the Enable Distributed Testing check box to distribute a
test. Once enabled, the rest of the fields on the Distributed tab are activated.

The check box is not enabled by default on new tests. However, once you
have set up a distributed test, if you save and close a test with the check box
enabled, it will reload in the enabled state.

The Main Test node on the Test Browser indicates if your test is set up to
be distributed. For example, if you have a distributed test containing 60
iterations, the node displays Main Test (60 Iterations) – Distributed, as
shown in the following figure.
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Selecting a User Configuration
You or an administrator must set up a user configuration in the Parallel
Computing Toolbox software before distributing tests in the SystemTest
software. The user configuration determines certain administrative options,
such as what scheduler is used. You can use The MathWorks™ job manager
that comes with MATLAB® Distributed Computing Server™, and the local
scheduler that comes with the Parallel Computing Toolbox software. You can
also use a third-party scheduler, such as Windows CCS, Platform Computing
LSF, mpiexec, or a generic scheduler.

In the User Configuration field on the Distributed tab, select the user
configuration that will be used when you distribute tests.

• The Default option indicates the configuration that is designated as the
default in the Parallel Computing Toolbox software. The name of the
configuration appears in parentheses.

• If you have any other configurations defined, they will appear in the
drop-down list under Default. Either use the default, or click the second
radio button and choose a user configuration from the list.
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In the following example, this user has several different schedulers and has
a separate user configuration for each scheduler. In this example, the user
configurations are named for the schedulers they use.

User configurations contain other information in addition to scheduler
selection, and are used to define other distributed computing parameters. See
Programming with User Configurations in the Parallel Computing Toolbox
documentation for details on setting up the user configuration.

If you load a test containing a user configuration that no longer exists, this
option will be in an error state. You can correct the error by selecting a valid
user configuration.
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Setting Up File Dependencies
Use the File Dependencies table to indicate files or folders of files to be
copied to the worker machines. If the worker machines need to access
files that your test is dependent on, you can add the names of the files or
directories of files as dependencies in the SystemTest software and they will
be copied to each worker.

Note: There is overhead in copying files for each task. If there are files that
can be accessed from a shared location by the worker machines, use Path
Dependencies instead. For example, if you use a Simulink element that
references a large model available from a shared network folder, you should
set a path dependency to the directory containing your model.

File dependencies can be defined in the File Dependencies table, as
described below, or can be defined in the user configuration that is set up in
the Parallel Computing Toolbox software. If there are any file dependencies
specified by the currently selected user configuration, they will also be listed
in this table, but will appear in italics and are not editable here. File names
you enter through the SystemTest software appear in regular text and are
editable here.

To set up a file dependency:

1 Click the File Dependencies tab within the Distributed tab.

2 Double-click the entry row in the table (the top row).

The row becomes a text field.

3 Do either:

• Type the full path and file or folder name in the field, and then press
Enter.

• Click the browse button in the entry row, browse to the file or folder,
then click Open in the browse dialog box.

The dependency you entered then appears as a new row in the list.
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The example below shows file dependencies for an M-file and a small model to
be copied to the worker machines.

If you want to delete a file dependency, select it and click the Delete button.
You can delete only dependencies added in the SystemTest software. You
cannot delete any that are specified by the user configuration.
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Setting Up Path Dependencies
Use the Path Dependencies table to indicate directories to be added to the
workers’ MATLAB path. If the worker machines need to access certain files
during the test, you can add the directories here. These directories are added
to the workers’ MATLAB path such that the necessary files can be located.
For example, if you use a Simulink element that references a large model
available from a shared network folder, you should set a path dependency to
the directory containing your model.

Note: If there are files that cannot be accessed from a shared location, use
File Dependencies instead.

You can enter path dependencies in the Path Dependencies table, as
described below, or in the user configuration that is set up in the Parallel
Computing Toolbox software. If there are any path dependencies specified
by the currently selected user configuration, they will also be listed on this
tab, but will appear in italics and are not editable in the SystemTest software.
Paths you enter through the SystemTest software appear in regular text
and are editable here.

To set a path dependency:

1 Click the Path Dependencies tab within the Distributed tab.

2 Double-click the entry row in the table (the top row).

The row becomes a text field.

3 Do either:

• Type the path in the field, and then press Enter.

• Click the browse button in the entry row, browse to the directory, then
click Open in the browse dialog box.

The dependency you entered then appears as a new row in the list.
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In the following example, because the model is very large the user set up a
path dependency for the directory containing the model that the test uses.

Notice in this example that the path is listed twice, once in Windows® format
and once in UNIX® or Linux® format. If you have a heterogeneous cluster
that contains both Windows and UNIX or Linux worker machines, you need
to add the path twice so that all workers can use it.

8-10



Setting Up Path Dependencies

Note Path dependencies must be listed in the format supported by the type
of worker machines the cluster contains, as shown in the previous figure
(which shows both styles). Also, for Windows machines that cannot be directly
accessed by all the workers, you need to specify the path as a UNC path.

If you want to delete a path dependency, select it and click the Delete button.
You can delete only dependencies added in the SystemTest software. You
cannot delete any that were specified by the user configuration.
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Distributing Iterations Across Tasks
The Distribution of main test runs across tasks option on the
Distributed tab determines the distribution of Main Test iterations into
tasks that the workers perform. The calculation is based on the total number
of iterations your test contains.

By default, the Default option is selected and the text in parentheses
shows the number of iterations per task and number of tasks. The default
is calculated by dividing the number of iterations in your test by 32 (an
approximation based on a setup of 8 workers, with a target of 4 tasks per
worker), and using the closest number to that. For example, if your test
has 90 iterations, the default will be 3 iterations per task and 30 tasks, as
shown below.

If you run your test and this does not seem efficient, you can change the
number of iterations per task and number of tasks. To change it:

1 Select the second option. The number field becomes editable.

2 Enter the number of iterations per task you want to use.
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3 Press Enter.

The number of tasks is then calculated (total number of iterations divided
by number of iterations per task) and shown in parentheses. For example,
if you had the same test with 90 iterations, but changed iterations per
task to 6, you get 15 tasks.
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Running a Distributed Test
You run a distributed test as you would run any other test, by clicking the
Run button in the SystemTest toolbar.

When you run a distributed test:

• Pre Test executes once, on the client machine (the machine from which
you run the test).

• Main Test iterations execute on the cluster of worker machines defined
by the user configuration.

• The SystemTest software waits for the distributed test to complete.

• If there are errors when the distributed test iterations run, only the first
error from the tasks will be reported to the Run Status pane in the
SystemTest software once all tasks have completed.

• At the end of each Main Test iteration, test results are saved and returned
to the client machine once all Main Test iterations have finished executing.

Note Because Main Test iterations run across a number of tasks, there is
no guarantee as to the order the tasks (Main Test iterations) will execute.
Tests should not be written with the assumption that iterations will execute
in a fixed order.

Also, because Pre Test runs on the client machine, and tasks run independent
of each other, Main Test iterations should not rely on data persisting across
multiple iterations.

• Post Test executes once on the client machine, after Main Test executes or
has errored while running.

• Test execution reports are generated at the end of the test, if enabled by
the test.

• Generated plots are not shown on the client machine while the test
runs, but are captured and displayed in the Test Report. Note that plots
generated on worker machines will only reflect information generated as
part of the task. Plotting multiple data points or lines on a single plot will
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only reflect the data pertaining to iterations executed as part of a single
task.

Note that MATLAB and the SystemTest software remain in a busy state until
the distributed test is done running or is stopped.

Caution It is recommended that you do not run a test containing
hardware-related elements in distributed mode. That includes the Image
Acquisition Toolbox element, the Data Acquisition Toolbox elements, and the
Instrument Control Toolbox elements. These elements will likely error out
because the connected hardware will not be available on the workers.

The following diagram illustrates the relationship between the SystemTest
software, the scheduler, and the workers. Task 1 to Task X and Iteration 1 to
Iteration N are determined by what is shown in the Distribution of main
test runs across tasks section in the Distributed tab. For example, if the
Distribution of main test runs across tasks for a test with 90 iterations
is set to Default (3 iterations per task, 30 tasks), that means your test
will execute 3 iterations for each of 30 tasks. In this case, Task 1 might run
iterations 1, 2, and 3, and Task 2 might run iterations 4, 5, and 6, etc.
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Example: Distributing a Test
The following general example shows how you can distribute any test you
have created.

You create and set up a distributed test as you would set up any test, using
the SystemTest desktop. If you determine that the test takes a long time to
execute, you may benefit from distributing it. You then use the Distributed
tab on Test Properties to set up the test distribution.

To distribute a test:

1 Select your test name in the Test Browser. Then click the Distributed
tab in the Test Properties pane.

2 Select the Enable Distributed Testing check box to enable distributed
testing and activate the other options on the tab.

3 The SystemTest software uses the user configurations set up in the Parallel
Computing Toolbox software. User configurations identify various settings,
such as which scheduler to use.

In the User Configuration section, keep the default user configuration, or
select the second radio button and choose a different configuration from the
drop-down list.

For more details, see “Selecting a User Configuration” on page 8-5.

4 If your test is dependent on files, such as models, M-files, or MAT-files, in
order to execute, you need to specify the dependent files so that the worker
machines can access the files while the test is running.

If there are files that need to be copied onto the worker machines, use the
File Dependencies tab. If there are files available on a shared network
location that need to be accessed by the worker machines, use the Path
Dependencies tab instead. For example, if you use a Simulink element
that references a large model available from a shared network folder, you
should set a path dependency to the directory containing your model.

Enter the necessary file or path dependencies into the respective tabs by
double-clicking the top row in the tables. For more details, see “Setting
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Up File Dependencies” on page 8-7 and “Setting Up Path Dependencies”
on page 8-9.

5 The SystemTest software will calculate number of iterations per task
for you, or you can specify that, in the Distribution of main test runs
across tasks section.

Use Default, or change it by selecting the second option, which enables the
number field. Enter the number of iterations per task you want to use and
press Enter or click outside the field.

For details on how these values are calculated, see “Distributing Iterations
Across Tasks” on page 8-12.

6 Run the distributed test as you would run any other test, by clicking the
Run button in the SystemTest toolbar.

For information on what happens when you execute a distributed test, see
“Running a Distributed Test” on page 8-14.
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Using the Test Results
Viewer

This chapter explains how to use the Test Results Viewer to explore and
analyze your test results.

• “Before You Begin” on page 9-2

• “A Quick Tour of the Test Results Viewer” on page 9-5

• “Viewing Your Test Results” on page 9-7

• “Refining Your Test Results” on page 9-28

• “Viewing Simulink Time Series Data” on page 9-37

• “Saving and Reloading Test Results” on page 9-42
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Before You Begin
The examples in this chapter use saved test results from the Throttle demo.
You can follow the explanations by loading and running the Throttle demo
from the MATLAB command line. The Throttle demo is configured to open
the Test Results Viewer upon completing a test.

See the SystemTest Demos page for an explanation of the Throttle demo.

Note This demo will not be listed if you do not have Simulink installed.

To prepare for the rest of this chapter:

1 Start MATLAB.

2 In MATLAB, select Start > Demos to open the Help browser opens.

3 Expand the MATLAB list from the left frame of the browser.

4 Click SystemTest. The SystemTest demos open in the right browser frame.

5 Under Simulink, click Validating a Throttle Body Model. An overview
of the demo opens.

6 Click the link Open the demo in the SystemTest desktop at the bottom
of the page.

Alternatively, you can enter the following command at the MATLAB
command line:

systemtest demosystest_throttle

After the SystemTest desktop appears, run the loaded test. Do one of the
following:

• Click the Run button.
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• Press the F5 key.

• Select Run > Run.

The SystemTest software runs the Throttle demo test, saves the specified test
results, and opens the Test Results Viewer when it finishes.
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Note The most common use case is to have the Viewer open automatically
after a test run, as described here. But you can also open the Viewer directly
from MATLAB by typing stviewer at the MATLAB command line. The
Viewer would open in an empty state. To open test results then, use the File
> Load Test Results menu command.
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A Quick Tour of the Test Results Viewer
The Test Results Viewer is organized to show you the test vectors you
specified as inputs to your test, the results saved from your test, and tools you
can use to plot and examine your test results.
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The test results and test vectors from your test are available in the Data
pane, which is a compact data browser. You choose your plot type, set your
display options to include what appears on the different axes, and plot your
data. The plotting tools let you select data from the plot to examine, and
you can see the actual values that resulted in individual plot points in the
Current Iteration pane, which will open automatically when you select a
plot point. If this pane is not visible, select Desktop > Current Iteration.
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“Viewing Your Test Results” on page 9-7, “Refining Your Test Results” on
page 9-28, and “Viewing Simulink Time Series Data” on page 9-37 explain
how to use the Test Results Viewer to plot and examine your test results.
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Viewing Your Test Results

In this section...

“Reserved Keywords” on page 9-7
“Browsing Results” on page 9-7
“Generating Plots” on page 9-8
“Exploring Plots” on page 9-15

Reserved Keywords
The Test Results Viewer has several reserved keywords that you cannot use
as a test result name or as a derived result name. These keywords are:

• time

• testrun

• testruns

• metadata

• data

If any of these keywords are used as a test result name, they will be prepended
with "st_" when loaded in the Test Results Viewer. If you try to use these
keywords as a derived result name in the Test Results Viewer, you will get
an error message.

Browsing Results
“Viewing Test Results in the Test Results Viewer” on page 1-39 notes that the
Test Results Viewer contains a data browser within the Data pane. This area
of the viewer is one of the first things you see when the Test Results Viewer
opens. It shows you the test variables and test vectors your test used, and it
shows information about their values in the Data Statistics area.

These data statistics summarize the values of a test result or test vector
across all of the tests. For example, the Throttle demo varies the parameters
for mass, damping, and stiffness of a Simulink model. Test vectors vary
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Simulink block parameters for 90 test iterations, and the SystemTest software
saves how these changes affect the position of a simulated throttle opening in
the position_sim test result.

If you click position_sim in the Results area of the Data pane, the Data
Statistics area shows you a summary of statistical information for all 90
iterations. In this example, you have not defined any constraints on your data,
so statistical information for the constrained and unconstrained columns is
the same. See “Creating and Applying Constraints” on page 9-28.

“Generating Plots” on page 9-8 explains how you can further explore your
test results.

Generating Plots
The Test Results Viewer has a plotting capability that helps you understand
your test results. You can determine how values of different inputs (test
vectors) affect the overall test results.

To generate any plot:

1 Click the button corresponding to the type of plot you want to generate.
The plot buttons are below the menu bar. For example, click the Line
Plot button. See “Choosing a Plot” on page 9-14 for an explanation of your
choices. You can also use the Plots menu to generate plots.
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2 Choose the data to use for your X-axis and Y-axis in the Define Plot pane.
For example, select *Auto* from the X Axis list and position_sim from
the Y Axis list to show the simulated throttle position trajectories at each
test iteration. See “Choosing a Plot” on page 9-14 to understand which
data types are available on each axis.

Note Selecting *Auto* when creating a plot means the plot will show the
exact number of values in the test vector or result you are plotting. For
example if you are plotting a test vector that has 50 values, and you select
*Auto* for one of the axes, that axis will display 50 points.

3 Choose a different plot type if you do not want to use the default. To choose
a different plot type:

a Click Plot type in the Define Plot pane.

9-9



9 Using the Test Results Viewer

b Click the plot type you want to use. For the Throttle demo example,
use the default sine wave.

4 Click the Plot button. The Test Results Viewer renders a plot based on
your selections.

Each line in the plot represents a test iteration. If it appears that there are
not as many lines as you had test iterations, it is possible that two or more
iterations generated similar enough results that they overlap.

Now you can analyze the plot. To help you with this task, you can:
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• Explore the plot using the plotting tools available to you as explained in
“Exploring Plots” on page 9-15.

• Refine what results are shown in your plot as explained in “Refining Your
Test Results” on page 9-28.

Plotting Grouped Test Vectors
You can plot grouped test vectors on both the X and Y axes of scatter plots.
Using grouped test vectors in plot configurations allows you to see the
relationship between the grouped vectors.

The following figure shows an example of a test that has two grouped test
vectors, TestVector1G and TestVector2G. The scatter plot allows both
grouped vectors to be shown in the plot, one on each axis. That is useful for
Monte Carlo simulation testing. For example, if you have two vectors that
vary the mass of two different components in a model, you could see them in
relation to each other.
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To plot two grouped test vectors in the viewer:

1 Select Scatter as your Plot type.

2 Select the first grouped test vector from the X Axis list.

3 Select the second grouped test vector from the Y Axis list.

4 Click the Plot button.

You will see a plot similar to the one shown above in which you can see how
the two test vectors relate to each other.

Using Grouped Test Vectors as Distinguishing Variables in Subplots

You can also use grouped test vectors as distinguishing variables in subplots.
You can select them in the Subplot drop-down lists next to the labels show
and and.

For example, in the example shown above, if a test variable TestVariable1
were plotted against a non-grouped test vector TestVector1Ungrouped,
TestVector1G could be used to distinguish the resulting scatter points using
different marker colors and TestVector2G could be used to distinguish them
by different subplot rows. The grouped test vectors would appear in the
subplot drop-down lists to allow this configuration.
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Choosing a Plot
There are six types of plots. The line plot, mesh plot, and time series plot
types have additional subtypes available. Additionally, the Test Results
Viewer has rules for determining which test results you can plot on the
X-axis, Y-axis, and Z-axis. These rules vary by plot type. The following table
explains these selections:

Plot Description

Line Standard line plot of Y versus X. Represents scalar or vector
data. The default is a wave line, but you can choose a square
line sub type. The following data are allowed on each axis:

• X — Numeric test vectors

• Y — Numeric test results
Surf Wireframe surf plot based on X, Y, and Z coordinates.

Optional surface sub type available. The following data are
allowed on each axis:

• X — Numeric test vectors

• Y — Numeric test vectors

• Z — Numeric test results
Scatter Standard scatter plot of X and Y where either axis can have

numeric test vectors or numeric test results.

Time Series Plots time series data Y against time (X is always time).
Designed to represent Simulink time series object data. The
default is a wave line, but you can choose a square line sub
type. See “Viewing Simulink Time Series Data” on page
9-37 for more information about this plot type.
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Plot Description

Waterfall Waterfall plot for vectors or time series. One vector or time
series can be displayed on each waterfall plot. The meaning
of the X, Y, and Z axes is as follows:

• X — Is automatically selected to be “*Auto*” if the Z axes
is assigned to a vector-valued test result, or “Time” if Z
axes is assigned to a time series test result.

• Y — You can select either Test Run or Iteration. In
the former case, if a test is excluded by application of
constraints a gap will appear in the waterfall plot at the
Y position corresponding to that test. In the latter case,
lines representing the test result displayed on the Z axis
are always placed in consecutive Y positions.

• Z — You can select either a single vector-valued numeric
test result or a single time series test result.

Image Lets you look at individual frames from an image sequence
saved during a test iteration. Data must be a supported
MATLAB Image format, and must be numeric test results
whose size is compatible with an image, namely that:

• It has three or four dimensions.

• The third dimension has a length of 1 or 3.

Exploring Plots
This section describes the tools the Test Results Viewer makes available to
help you understand its generated plots. It contains the following topics:

• “Plotting Tools” on page 9-16 describes the tools available to help you
examine and understand the contents of a generated plot.

• “Viewing Individual Iteration Values” on page 9-16 shows how to focus on
specific iteration test results in a plot.

• “Highlighting Values in Your Plot” on page 9-20 shows how to distinguish
test results in a plot.
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• “Exposing Overlapping Plot Lines” on page 9-24 explains how you can view
individual lines in a plot that shows multiple test result values as the same
line.

Plotting Tools
The Test Results Viewer integrates the MATLAB Figure Toolbar, which
lets you examine and distinguish the test results shown in your plots. See
“Plotting Tools—Interactive Plotting” and “Data Exploration Tools” in the
MATLAB Graphics documentation for more information.

In addition, the viewer also supports the desktop arrangement tools available
in the MATLAB editor. See “Arranging the Desktop — Overview” in the
MATLAB documentation.

The Test Results Viewer adds the following features to the MATLAB Figure
Toolbar:

• Test run selection — Lets you click different test runs in the plot and see
the test vector and test results for that iteration in the Current Iteration
pane. “Viewing Individual Iteration Values” on page 9-16 shows an
example of how to use this.

• Lock the plot — Prevents constraints from changing the test results
displayed in the plot.

Viewing Individual Iteration Values
Every test iteration has its own representation in a plot unless you screened
it out with a constraint (“Refining Your Test Results” on page 9-28 explains
constraints). By clicking a line, marker, or surface in a plot with the test run
selection tool, you can see the information associated with that test iteration
in the Current Iteration pane.

For example, “Generating Plots” on page 9-8 demonstrates how to generate
a plot showing all test iteration results of the Throttle demo. You can use
the Test Results Viewer plotting tools to zoom in on areas of the plot and
determine which iteration was responsible for the result.

1 Click the Zoom In button.
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2 Move the mouse pointer over an area of the plot you want to investigate
further.

3 Left-click your mouse or click and drag over the area you want to see. The
plot redraws to show this area.

You can repeat zooming in until you have the level of detail you want.
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4 To turn off the Zoom, click the Zoom In button again.

5 Click the Select an iteration button in the Figure Toolbar.

6 Click one of the plotted lines in the line plot. The viewer marks the line.
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The viewer simultaneously populates the Current Iteration pane with
information about the values for all test vectors and test results for your
selected test iteration. This lets you easily see what test conditions generated
a specific result.
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Highlighting Values in Your Plot
The Test Results Viewer lets you further distinguish your test results for any
given plot by letting you control how a plot renders the data on each axis.
This is useful in deciphering test results on a plot—especially when the initial
plot has a large number of test results closely grouped together. This section
explains how you use the Define Plot pane to modify the appearance of your
plot without modifying the underlying test results. (See “Refining Your Test
Results” on page 9-28 for information about modifying the test results used
to render a plot.)

The Define Plot pane provides four ways to distinguish plotted test results:

• Color

• Markers

• Subplot rows

• Subplot columns

For example, the Throttle demo shows the effect of variations in mass,
damping, and stiffness on a component of a Simulink model. The plot you
generated in “Generating Plots” on page 9-8 shows test results for of all test
iterations, but it is impossible to determine how changes to each test vector
affected this outcome. To distinguish the test results on the plot:

1 Zoom in on an area of the line plot so that you can see individual test
iterations (as explained in “Viewing Individual Iteration Values” on page
9-16).
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2 In the Define Plot pane, click Show > Damping.

3 Select color from the as list.

4 Click the Refresh Plot button. The plot lines change to show a range
of colors.
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You now have some idea how damping has affected the test results. You have
a cluster of blue, green, and red indicating that damping is the same value in
each cluster, which you can confirm by using the test selection tool to choose
lines and by viewing the value for the Damping test vector in the Current
Iteration pane.

You can modify the appearance of another set of test vectors to further
understand the test results. For example, the menu below Damping can be
used to distinguish variations in mass with markers.

1 Click the menu next to and.

2 Select Mass from the list.
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3 Click the menu next to as and select marker type.

4 Click the Refresh Plot button.

The viewer redraws the plot to show markers distinguishing variations in
mass. Notice how each cluster of lines has its own unique color and marker,
which shows that variations in damping and mass have a visible effect when
you run the model.

You can add two more rows using the + button in the Define Plot pane to
distinguish your test results further.
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Note These colors and markers do not necessarily show the same value
throughout the overall plot. The viewer cycles through all colors and markers
in the palette making it possible for different test result values to have the
same color or marker.

Exposing Overlapping Plot Lines
It is possible for plot lines and points to overlap and appear undistinguishable.
When multiple lines overlap, you can create subplots to distinguish the data
points.

For example, if you create a line plot for the Throttle demo with the X-axis
set to *Auto* and the Y-axis set to position_sim, the Test Results Viewer
renders a plot with plot lines in close proximity.
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This plot has 90 lines that are too close together to be able to discern clear
patterns. You can use the Define Plot pane to distinguish plots of test results
by placing the generated lines of a test in individual subplots. Each subplot
shows the test vector values associated with the test results being plotted.
The number of runs per test vector value determines how many subplots you
can generate. Using the Throttle demo, you can generate subplots based on
changes in damping, mass, or stiffness. For example, what effect did changes
in mass have on these test results? To show its effect:

1 In the Define Plot pane, select Show > Mass.
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2 Select subplot rows from the as list.

3 Click the Refresh Plot button.

The viewer now shows three subplot diagrams, one for each value of the
Mass test vector.
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Refining Your Test Results

In this section...

“Creating and Applying Constraints” on page 9-28
“Plotting Single Iterations” on page 9-35

Creating and Applying Constraints
This section explains how you create and apply constraints to restrict the test
results to a subset of test iterations. You also see how to use a constraint
to walk through a set of test results.

Constraints are a Test Results Viewer mechanism that screen out test result
values. Constraints can be a single value, a range, or an evaluated expression.
Applied constraints result in plots rendered from a subset of test iterations,
and the viewer applies constraints immediately to all plots. This is useful
when you want to screen out or filter test results in your attempts to find
or understand the results of a test.

Using Default Constraints
The Test Results Viewer, when opened after a test run, has constraints
present but not applied. The viewer creates a constraint for each test vector
and defines the constraint’s range as a function of the full range of values in
the test vector. These default constraints let you see the immediate effect of
your test’s test vectors on the results of the test.

For example, the Throttle demo has three test vectors corresponding to
changes in damping, mass, and stiffness to a Simulink model. If you display a
line plot as explained in “Generating Plots” on page 9-8, you get a plot similar
to the following:
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This output shows that the test results group in small clusters. You can use a
constraint to see which of the test vectors cause this clustering.

1 Return the plot to the previous state by clicking the menu next to as and
clicking color, then click the Refresh Plot button.

2 In the Constraints pane, select the check box next to the Damping
constraint. The constraint becomes active showing all tests with a Damping
greater than or equal to 5.0, which is the lowest value in the range of test
vectors. All test results remain in the plot.
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3 Click the right-pointing arrow at the end of the Damping constraint’s
slider.

���-�
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This advances the constraints slider by one value of the test vector, which
causes the first value of the Damping test vector to be removed from the test
results used in generating the plot. The viewer immediately applies this
constraint to the plot, which, in this case, removes the left-most cluster of test
results from the plot.
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The constraint counter gives another way for you to see whether the
constraint affected the test results. In this case, if you set the constraint
value to 7, the bar shows that there are only 72 of 90 test iterations visible
because of the constraint you just created. Thus these 18 test iterations that
are screened out have a Damping test vector value greater than or equal to 7
(see “Creating a Test Vector” on page 1-15 to understand test vector values).
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Creating a Constraint
The Test Results Viewer lets you create a custom constraint based on the
following:

• A mathematical expression

• Scalar logical test results

• Scalar numeric test results

• String test results that have a value for each test iteration

• Test vectors

You can see an example for creating a constraint based on a mathematical
expression in “Viewing Test Results in the Test Results Viewer” on page 1-39.

A constraint you might want to create regularly would isolate test results
that have passed or failed. This is useful if your test contains a Limit Check
element that assigns data to a test variable that you choose to save as a test
result. When this test variable is saved, the SystemTest software records the
test iteration and whether the test passed or failed (represented by a 1 or 0);
you can create a constraint based on these test results. For example:
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1 If you activated the Damping constraint in “Using Default Constraints” on
page 9-28, deactivate it now by clearing the check box next to Damping,
or delete it.

2 Click the New Constraint button.
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The Add a New Constraint dialog box appears.

3 Click the list beneath the Using a result or test vector field to show the
list of test vectors and test results available for basing a constraint on.

4 Scroll down and select pass_fail in this list. This is the name of the test
result that is used to save the Throttle demo’s Limit Check element’s
output.

5 Click OK. The viewer adds the new constraint to the Constraints pane,
but it is not active.

6 Select the check box next to the pass_fail constraint to apply it.
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7 Change the operator to ==. The value is already set to 0, representing
failed test iterations.

You now have a constraint set to show only those test iterations that failed.
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If you change the value of the constraint to 1 using the slider, you will show
only those test results that passed the Limit Check element in your test.
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Plotting Single Iterations
The constraint option Plot single iteration at a time lets you step through
and see individual test results within the subset defined by the active
constraints. The plot shows only one test iteration until you choose to show
the next or previous one. The specific values for that test iteration’s test
vectors and test results appear in the Current Iteration pane. This is useful
when you want to know what combination of test vectors allow a test to pass,
or what values can lead to failure.

For example, if you follow “Creating a Constraint” on page 9-32, by the end
you have created a constraint that shows you all test iterations that have
passed. To see each iteration individually:

1 Move the slider for the pass_fail constraint back to 0.

2 Select the Plot single iteration at a time check box in the Constraints
pane.

9-35



9 Using the Test Results Viewer

The Constraints pane changes to show a slider and the currently
displayed test iteration.

3 Move the slider or click the advance button to see the next iteration. You
see only those test results that match any defined constraints, which, in
this case includes only those tests that have passed.
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The Plots pane updates to show only the plotted line for that iteration.
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Viewing Simulink Time Series Data

In this section...

“Overview” on page 9-37
“Creating a Time Series Plot” on page 9-37

Overview
The Test Results Viewer lets you plot test results over time. Simulink can
generate time series data when it runs a model, and the SystemTest software
can use this data to generate time series plots. Instead of knowing simply
that a change in a test vector resulted in a specific test result value, you can
now know when during the test that the test vector caused that test result
value to be achieved.

This section shows how you plot test results containing time series data. The
examples in this section use the model from the Inverted Pendulum demo;
if you want to load this model and follow the examples in this section, see
“Before You Begin” on page 4-2.

Creating a Time Series Plot
Time series plots require that you have time series data. Your test results
will contain time series data because of any of the following:

• Time series data is generated from Simulink Logged Signals and Simulink
To Workspace signals.

• The time series data was explicitly created in a MATLAB element and
assigned to a test variable that was saved as a test result.

• The viewer created a derived result that represents time series data
constructed from Simulink structs (with time data) or log signals. These
new derived results have names derived from their original test result
name and value.

You can verify whether your test generated time series data by reviewing the
test results list in the Test Results Viewer’s Data pane. The viewer labels
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time series test results as being of type Simulink.Timeseries (Simulink
saves time series data within the workspace in Model Data Logs objects).

To create a time series plot:

1 Run the test in the SystemTest software.

2 Click the Time Series Plot button in the viewer.

3 In the Define Plot pane, click the Y Axismenu to show a list of test results
with time series data. The Y Axis field shows only test results with time
series values. The X Axis field is always set to Time in a time series plot.
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4 Click the test result you want to use. For the Inverted Pendulum example,
click st_loggedsignal.

5 Click the Refresh Plot button.

The Test Results Viewer generates a time series plot with your selected data.
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At this point, you can use the data exploration and refinement tools explained
in “Viewing Your Test Results” on page 9-7 and “Refining Your Test Results”
on page 9-28 to make more sense of the test results in the plot.

For example, you can use a constraint to step through each individual
iteration, by selecting the Plot single iteration at a time check box.
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As this example shows, the time series test result for a single test iteration
is composed of many values over time. There are many points with uneven
spacing reflecting the actual values of the signal over the time period.
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Saving and Reloading Test Results

In this section...

“Saving Test Results” on page 9-42
“Loading Test Results” on page 9-43

Saving Test Results
You can save the plotting and analysis work done in the Test Results Viewer.
Data, constraints, and plots created in the Test Results Viewer can be saved
and then reloaded in order to continue working on or viewing the data, or to
share it with others.

The following information will be saved:

• The data set created by the SystemTest software during your test run.

• Derived variables you create in the viewer.

• The layout state of the data tables (the order of the columns).

• Any constraints that you set up, and their order.

• Any plots you create, and their layout within the viewer.

Note Since any modifications made in the viewer could potentially be saved,
you will see the “file modified” indicator as soon as you do any actions in
the viewer, that is, the asterisk denoting a file as modified will be shown in
the viewer title bar.

To save your test results and the state of the Test Results Viewer, use the
File > Save Test Results or File > Save Test Results As commands from
the Test Results Viewer desktop.

When you use these save commands, a MAT-file is created that contains
all of the information listed above.
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Loading Test Results
There are four ways you can load test results in the Test Results Viewer.

• Load a saved results file from the File > Load Test Results menu in
the Test Results Viewer desktop.

• Load a saved results file from the MATLAB command line by typing
stviewer('matfilename'), where 'matfilename' is the name of the MAT
file containing your results.

• Open the Test Results Viewer automatically after a test runs in the
SystemTest software. To do this, be sure that the Visualize and plot
saved results by launching the Test Results Viewer option is selected
in the Test Properties pane in the SystemTest desktop before you run the
test. After the test executes, the Viewer is opened and the test results you
mapped in Saved Results are displayed.

• Open the Test Results Viewer any time after a test runs in the SystemTest
software by using the Tools > Test Results Viewer menu command or
the Test Results Viewer toolbar button from the SystemTest desktop.
The results of the last test that was executed will be opened in the viewer.
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Viewing Test Results at the Command Line

In this section...

“Introduction” on page 10-2
“Accessing the Results Summary” on page 10-2
“Accessing the dataset Array” on page 10-5

Introduction
After you run a test , the SystemTest software will automatically populate the
MATLAB workspace with a variable called stresults. This variable provides
access to the test results object, which is useful for comparing the results of
separate test runs and for postprocessing test results.

Note You can also view and postprocess test results in the Test Results
Viewer if you use the Visualize and plot saved results by launching the
Test Results Viewer option in Test Properties. See Chapter 9, “Using the
Test Results Viewer” for more information about using the viewer.

Accessing the Results Summary
You access the results using the stresults variable. To see an example, use
the Fault Tolerant Fuel Control System demo.

1 To open the demo in the SystemTest software, type the following at the
MATLAB command line:

systemtest demosystest_fuelctrl

2 Run the test by clicking the Run button on the SystemTest toolbar.

3 To view the results after the test runs, return to MATLAB and type:

stresults

The test results object looks like the following for the Fault Tolerant Fuel
Control System demo:
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The summary shows the number of iterations that ran, the names of the test
vectors included in the test, the saved results you specified in Save Results,
the dataset array, and generated artifacts.

NumberOfIterations reflects how many iterations actually executed when the
test ran. This will match what is reflected in the SystemTest software in the
Main Test node of the Test Browser if all iterations ran. If any iterations
stopped or errored out, this will show only the number that did execute.

TestVectorNames is a 1-by-N string cell array containing the test vector
names. The values are an alphabetical list of test vector names.

SavedResultNames is a 1-by-N string cell array containing the test result
names. The values are an alphabetical list of test result names.

ResultsDataSet is the dataset array storing the test vector and test result
values for each iteration. See “Accessing the dataset Array” on page 10-5 for
information on accessing the test results data.

Artifacts provides links to SystemTest-generated documents, such as the
test report. You can open the report by clicking the link. If your test includes
a model coverage report, that would also be included here.
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Accessing Properties of the Test Results Object
You can see a complete list of test results object properties before looking at
the actual test results data. At the command line, type:

get(stresults)

In the example using the Fault Tolerant Fuel Control System demo, you
see the following properties:

In addition to information that is also included in the summary, this includes
derived results names, start time, stop time, tags, and user data.

DerivedResultNames contains values if you created any derived results using
the Test Results Viewer. In the previous example there are no derived results,
so the value is {}. If there were derived results, this property would contain
an alphabetical list of their names.

StartTime provides the time the test was started in the form of a MATLAB
clock vector.

StopTime provides the time the test was stopped in the form of a MATLAB
clock vector.

TestFile stores the full path and name of the test that generated the test
results. If the test has been saved, the value will contain the full path and
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name of the test. If the test has not yet been saved, the value will show only
the test name.

Tag displays any string you specified using the set function. It is a descriptive
string used for labeling purposes. By default, this property is empty.

UserData is a property for storing user data. It is used to store any arbitrary
MATLAB data you would like to associate with the test results object. By
default, this property is empty.

Accessing the dataset Array
The ResultsDataSet property contains the test results data in the form of a
dataset array. This is what you set up using the Saved Results node in the
Test Browser. See “Saving Test Results” on page 1-30 for more information
on setting up saved results.

To access the test results data:

1 After running a test, use the stresults variable to view the test results
object summary, as described in the previous section.

2 To access the ResultsDataSet property, type:

stresults.ResultsDataSet

or

get(stresults, 'ResultsDataSet')

This returns the test results data in the form of a dataset array.

In the Fault Tolerant Fuel Control System demo example, a portion of the
test results data looks like this:
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In the dataset array, each row represents a test iteration, labeled using the
convention of ['I' + Iteration_Number]. The previous example shows the
first 10 iterations. Test vector values are listed first, in alphabetical order,
as shown, followed by test results, listed in alphabetical order, as shown in
the following figure.
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Notice that this example shows the test vectors list for the last two iterations
(I95 and I96), and the beginning of the display of the test result values. There
are five results, shown in alphabetical order. The display wraps in MATLAB,
so the fifth result is shown after all the iterations for the first four.

In this example, the value for AvgAirFuel is 14.4466 for the first iteration,
11.8858 for the second iteration, etc.
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Working with Test Results

In this section...

“Introduction” on page 10-8
“Managing Test Results Data in its Native Format” on page 10-8
“Managing Test Results as a Dataset Array” on page 10-9
“Plotting Results Data” on page 10-10

Introduction
After accessing test results data in the form of a dataset array, you can work
with the data in MATLAB. This feature is useful for comparing the test
results data of separate test runs and for postprocessing of test results data.

One advantage to accessing test results data at the command line is that all of
the MATLAB plotting tools are available to use on the test results data. You
can plot the data using any of the plot types MATLAB offers.

Another major use of the datatset array is to quickly see the results when
you use a Limit Check element in your test. You can see whether each
iteration passed or failed, and what the value was.

Managing Test Results Data in its Native Format
You can use indexing to extract out data of the dataset in its native format.
You can index by string or value.

For example, you can assign a variable to represent the dataset, then access
one column of the set using that variable. In the case of the Fault Tolerant
Fuel Control System demo this example has been using, it could look like
the following.

1 Create a variable to refer to the test results dataset array:

SetA = stresults.ResultsDataSet;

In this example the test results data is assigned to the variable SetA.
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2 Specify the desired columns of data by referencing the name of the test
result.

SetA.AvgFuelRate

This indexed into the column called AvgFuelRate.

Note When extracting data in its native format, the test results are always
returned as a cell array.

MATLAB displays the contents of that column of data, as shown in this
example:

The first 10 iterations are shown in the example.

Managing Test Results as a Dataset Array
You can also choose to manage the test results as a dataset array, refining
the data as finely as needed. Suppose you just want to get the average fuel
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rate for iterations 4 through 8. Use standard MATLAB indexing, as shown
in the next example:

The value returned represents the average fuel rate for iterations 4 through
8, in the form of a dataset array.

Plotting Results Data
To demonstrate plotting results, you can use another demo called Simple
Demo.

1 Open the demo in the SystemTest software by typing the following at the
MATLAB command line:

systemtest simple_demo

2 Run the test by clicking the Run button on the SystemTest toolbar.

3 View the results summary using stresults at the command line.
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You can see that this test has one test vector for a signal, called signal,
and three saved results. The result for Y is the signal’s value for a given
test run.

4 Look at the test results dataset by typing the following:

stresults.ResultsDataSet

The first 10 iterations are shown here:
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You can see the test vector signal followed by the three results, including
the one of interest in this example, Y.

5 Create a variable called SetB for the results dataset for ease of use in
working with the data.

SetB = stresults.ResultsDataSet;

6 Create variables for the signal (the test vector) and the Y test result.

signalA = SetB.signal;
VarA = SetB.Y;

7 Plot the signal. Because Y represents the current value of the signal for
each iteration of the test, plotting the signal against Y shows the values
of the signal throughout the test.

plot([signalA{:}], [VarA{:}])

The plot command produces a line plot, as shown here. You can use any
type of plot that MATLAB offers.
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To use another plot type, such as a scatter plot, replace the plot command.

scatter([signalA{:}], [VarA{:}])
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Accessing Test Results While a Test is Running
While a test is executing in the SystemTest software, you can access test
results using the systest.testresults.getCurrent method.

The getCurrent function is intended to be used in a MATLAB element within
the Pre Test, Main Test, or Post Test sections of a TEST-File, in order to
access test information or test results during test execution.

This is a function of the systest.testresults class, which is the class
definition for a test results object, allowing you to access test results from
MATLAB.

The following example used in a MATLAB element will allow you to access
the test results object while the test is executing. The ResultsDataSet
property can be queried in order to access the underlying test data that
is currently available.

obj = systest.testresults.getCurrent;
currentResults = obj.ResultsDataSet;
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addArtifact

Purpose Add artifact to test results object

Syntax addArtifact(obj, name, filepath)

Description addArtifact(obj, name, filepath) adds an artifact to the
test results object obj using the string name, representing a
user-customizable display name, and the string filepath, representing
the full file path to the artifact.

This function is a convenience for adding additional artifacts to the
Artifacts property of the test results object obj.

Artifacts can be any document or report associated with a test results
object. By associating artifacts with a test results object, hyperlinks are
automatically provided to access the artifacts when the test results
object is displayed at the MATLAB command line.

This is function of the systest.testresults class, which is the class
definition for a test results object, allowing you to access test results
from MATLAB. For more information on the test results object, see
Chapter 10, “Accessing Test Results from the MATLAB Command
Line”.
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Purpose Access test results object fromSystemTest TEST-File

Syntax obj = systest.testresults.getCurrent

Description obj = systest.testresults.getCurrent returns obj, the test results
object associated with the currently running SystemTest test file.

If no TEST-File is currently executing, obj is returned as [].

The getCurrent function is intended to be used in a MATLAB element
within the Pre Test, Main Test, or Post Test sections of a TEST-File, in
order to access test information or test results during test execution.

This is function of the systest.testresults class, which is the class
definition for a test results object, allowing you to access test results
from MATLAB. For more information on the test results object, see
Chapter 10, “Accessing Test Results from the MATLAB Command
Line”.

Examples The following code example used in a MATLAB element will allow
you to access the test results object while the test is executing. The
ResultsDataSet property can be queried in order to access the
underlying test data that is currently available.

obj = systest.testresults.getCurrent;
currentResults = obj.ResultsDataSet;
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strun

Purpose Run series of SystemTest test files

Syntax strun(testfile)

Description strun(testfile) runs the SystemTest test file specified by the string
testfile. You can specify testfile as the name of a test file, or as the full
path to a test file. If a test file name is specified without a full path, the
test file must reside on the MATLAB path.

testfile may also be specified as a 1-by-N or N-by-1 cell array of test
files, each of which is run serially.

Running tests that you set up in the SystemTest software from the
MATLAB command line using strun is useful for running multiple test
files as a batch or calling a test file as part of an M-file.

strun will run in a synchronous manner, that is, the MATLAB
command line will be blocked until strun finishes executing. strun will
finish executing when either of the following conditions is met:

• All test files have finished executing.

• A Ctrl+C is issued.

When a test is run, it is executed using the settings specified in the test
file. The only exception is the option to launch the Test Results Viewer.
If this option is enabled, it will be ignored.

If only one test file is specified, and the test encounters an execution
error, strun will error. If multiple test files have been specified, a
warning will be issued for any test execution errors, and the remaining
test files will be run.

Note It is recommend that you run the test from the SystemTest
desktop to verify that elements are not in an error state, and the test
will run successfully, before running it via the MATLAB command line
using this function.
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Note MATLAB will remain busy while tests are executing via the
strun command. Control is returned to the MATLAB command line
once all tests execute.

Examples Run a test called mytest that is on the MATLAB path.

strun('mytest')

Run a test called mytest that is not on the MATLAB path, but is in
a local directory called c:\work.

strun('c:\work\mytest.test')

Run two tests, called mytest and mytest2, that are both on the
MATLAB path.

strun({'mytest' 'mytest2'})

Run three tests, two of which are on the MATLAB path, and one of
which is not.

strun({'mytest' 'c:\work\mytest2.test' 'mytest3'})
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stviewer

Purpose Open Test Results Viewer

Syntax stviewer(filename)

Description stviewer(filename) opens the Test Results Viewer using the test
results saved in the MAT-file specified by the string filename.
filename must specify a MAT-file created by a SystemTest test.

Note that this function opens the Test Results Viewer directly from
MATLAB. The most common use case is to open the Test Results
Viewer from the SystemTest software at any time to see the results of
the last executed test, or automatically after a test runs that contains
test results.

For more information about the Test Results Viewer, see Chapter 9,
“Using the Test Results Viewer”.
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systemtest

Purpose Open SystemTest desktop

Syntax systemtest
systemtest(testfile)

Description systemtest opens the SystemTest desktop with a new untitled test.

systemtest(testfile) opens testfile in the SystemTest desktop, where
testfile is a SystemTest test file (.test) available on the MATLAB path
or specified with a full path.

Examples Open a test called mytest that is on the MATLAB path.

systemtest('mytest')

Open a test called mytest that is not on the MATLAB path, but is in
a local directory called c:\work.

systemtest('c:\work\mytest.test')
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SystemTest Hot Keys

The following keyboard shortcuts are available in the SystemTest software.

Key Description

Alt+N Activates the New button to create a new test
vector or test variable.

F1 Opens Help.
F5 Runs a test.
Ctrl+C While a test is running, stops the test.
Ctrl+C When a test is not running, copies selection in

some parts of the user interface.
Ctrl+N Adds a new untitled test.
Ctrl+O Opens a test.
Ctrl+Q Closes the SystemTest software.
Ctrl+S Saves a test.
Ctrl+V Pastes the copied selection.
Ctrl+W Closes a test.
Ctrl+X Cuts a selection in some parts of the user

interface.
Ctrl+Y Performs redo of last undo action.
Ctrl+Z Performs undo of last action.
Ctrl+0 Gives focus to the Test Browser.
Ctrl+1 Gives focus to the Properties pane.



A SystemTest™ Hot Keys

Key Description

Ctrl+2 Gives focus to the Test Vectors pane.
Ctrl+3 Gives focus to the Test Variables pane.
Ctrl+4 Gives focus to the Resources pane.
Ctrl+5 Gives focus to the Run Status pane.
Ctrl+6 Gives focus to the Desktop Help pane.
Ctrl+7 Gives focus to the Elements pane.
Ctrl+8 Gives focus to the Getting Started pane.
Ctrl+Shift+0 Gives focus to the Plots pane.
Ctrl+Shift+U Undocks the currently selected pane.
Ctrl+Shift+D Docks the currently selected pane.
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Dataset Arrays

In this section...

“Overview” on page B-2
“Test Results Data” on page B-3
“Looking at Data” on page B-3

Overview
When you run a test, you can view your test results data in the Test Results
Viewer, or as a dataset array in MATLAB. This appendix contains general
information on the dataset array that is the format used for test results that
can be accessed in MATLAB. See Chapter 10, “Accessing Test Results from
the MATLAB Command Line” for information on using the command-line
test results.

Dataset arrays are used to collect heterogeneous data and metadata including
into a single container variable. Dataset arrays can be viewed as tables
of values, with rows representing different observations and columns
representing different measured variables. Dataset arrays can accommodate
variables of different types, sizes, units, etc.

Note In the SystemTest software, each observation (i.e., row) is used to
represent a test iteration, while each measured variable (i.e., column)
represents a test vector or test result value.

Dataset arrays combine the organizational advantages of basic MATLAB data
types while addressing their shortcomings with respect to storing complex
heterogeneous data.

Dataset arrays have a family of functions for assembling, accessing,
manipulating, and processing the collected data. Basic array operations
parallel those for numerical, cell, and structure arrays.
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Test Results Data
MATLAB data containers (variables) are suitable for completely homogeneous
data (numeric, character, and logical arrays) and for completely heterogeneous
data (cell and structure arrays). Test results data, however, are often a
mixture of homogeneous variables of heterogeneous types and sizes. Dataset
arrays are suitable containers for this kind of data.

Dataset arrays can be viewed as tables of values, with rows representing
different test iterations or cases and columns representing different test
vector and test result values. Basic methods for creating and manipulating
dataset arrays parallel the syntax of corresponding methods for numerical
arrays. Because of the potentially heterogeneous nature of the data, dataset
arrays have indexing methods with syntax that parallels corresponding
methods for cell and structure arrays.

Looking at Data
Dataset arrays in MATLAB are variables created with the dataset function,
and then manipulated with associated functions. In the case of the
SystemTest software, when a test is run, a dataset array is created and stored
as part of a test results object. The test results object is assigned to a variable
named stresults in the MATLAB workspace when the test stops running.
See Chapter 10, “Accessing Test Results from the MATLAB Command Line”
for information on using stresults.

The following table lists the accessible properties of dataset arrays. Properties
can be configured using the set function, or accessed using the get function.

Dataset
Property

Value

Description A string describing the data set. The default is an empty
string.

Units A cell array of strings giving the units of the variables
in the data set. The number of strings must equal the
number of variables. Strings may be empty. The default is
an empty cell array.
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Dataset
Property

Value

DimNames A cell array of two strings giving the names of the rows
and columns, respectively, of the data set. The default is
{'Observations' 'Variables'}.

UserData Any variable containing additional information to be
associated with the data set. The default is an empty array.

ObsNames A cell array of nonempty, distinct strings giving the names
of the observations in the data set. The number of strings
must equal the number of observations. The default is an
empty cell array.

VarNames A cell array of nonempty, distinct strings giving the names
of the variables in the data set. The number of strings
must equal the number of variables. The default is the
cell array of string names for the variables used to create
the data set.

Functions associated with dataset arrays are used to display, summarize,
convert, concatenate, and access the collected data. Examples include disp,
summary, double, horzcat, and get, respectively. Many of these functions
are invoked using operations analogous to those for numerical arrays, and
do not need to be called directly. (For example, horzcat is invoked by [].)
Other functions access the collected data and must be called directly (for
example, replacedata).

Dataset arrays are implemented as MATLAB objects; the associated functions
are their methods. It isn’t necessary to understand objects and methods to
make use of dataset arrays—in fact, dataset arrays are designed to behave as
much as possible like other, familiar MATLAB arrays.
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Dataset Array Operations
This table lists available methods for dataset arrays. Many of the methods are
invoked by familiar MATLAB operators and do not need to be called directly.
For full descriptions of individual methods, type

help dataset/methodname

Dataset
Method

Description

cat Concatenate dataset arrays. The horzcat and vertcat
methods implement special cases.

dataset Create dataset array.
datasetfun Apply function to each variable of dataset array.
disp Display dataset array, without printing data set name.
display Display dataset array, printing data set name. This

method is invoked when the name of a dataset array is
entered at the command prompt.

double Convert dataset variables to double array.
end Last index in indexing expression for dataset array.
get Get dataset array property.
horzcat Horizontal concatenation for dataset arrays (add

variables). This method is invoked by square brackets.
isempty True for empty dataset array.
join Merge observations from two dataset arrays.
length Length of dataset array.
ndims Number of dimensions of dataset array.
numel Number of elements in dataset array.
replacedata Convert array to dataset variables.
set Set dataset array property value.
single Convert dataset variables to single array.
size Size of dataset array.
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Dataset
Method

Description

sortrows Sort rows of dataset array.
subsasgn Subscripted assignment for dataset array. This method is

invoked by the parenthesis, dot, and curly brace indexing.
subsref Subscripted reference for dataset array. This method is

invoked by the parenthesis, dot, and curly brace indexing.
summary Print summary statistics for dataset array.
unique Unique observations in dataset.
vertcat Vertical concatenation for dataset arrays (add

observations). This method is invoked by square brackets.
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